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Safety Instructions • English

WARNING:	 This symbol, , when used on the product, is intended to 
alert the user of the presence of uninsulated dangerous voltage within 
the product’s enclosure that may present a risk of electric shock.

ATTENTION: This symbol, , when used on the product, is intended to alert 
the user of important operating and maintenance (servicing) instructions in the 
literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide, part number 68-290-01, on the Extron 
website, www.extron.com.

Instructions de sécurité • Français

AVERTISSEMENT:	 Ce pictogramme, , lorsqu’il est utilisé sur le 
produit, signale à l’utilisateur la présence à l’intérieur du boîtier du 
produit d’une tension électrique dangereuse susceptible de provoquer 
un choc électrique.

ATTENTION:  Ce pictogramme, , lorsqu’il est utilisé sur le produit, 
signale à l’utilisateur des instructions d’utilisation ou de maintenance 
importantes qui se trouvent dans la documentation fournie avec le 
matériel.

Pour en savoir plus sur les règles de sécurité, la conformité à la 
réglementation, la compatibilité EMI/EMF, l’accessibilité, et autres sujets 
connexes, lisez les informations de sécurité et de conformité Extron, réf. 
68‑290-01, sur le site Extron, www.extron.fr.

Sicherheitsanweisungen • Deutsch

WARNUNG:  Dieses Symbol  auf dem Produkt soll den Benutzer darauf 
aufmerksam machen, dass im Inneren des Gehäuses dieses Produktes 
gefährliche Spannungen herrschen, die nicht isoliert sind und die einen 
elektrischen Schlag verursachen können.

VORSICHT:  Dieses Symbol  auf dem Produkt soll dem Benutzer 
in der im Lieferumfang enthaltenen Dokumentation besonders 
wichtige Hinweise zur Bedienung und Wartung (Instandhaltung) 
geben.

Weitere Informationen über die Sicherheitsrichtlinien, Produkthandhabung,  
EMI/EMF-Kompatibilität, Zugänglichkeit und verwandte Themen finden Sie in 
den Extron-Richtlinien für Sicherheit und Handhabung (Artikelnummer 68‑290-
01) auf der Extron-Website, www.extron.de.

Instrucciones de seguridad • Español

ADVERTENCIA:	 Este símbolo, , cuando se utiliza en el producto, 
avisa al usuario de la presencia de voltaje peligroso sin aislar dentro 
del producto, lo que puede representar un riesgo de descarga 
eléctrica.

ATENCIÓN:  Este símbolo, , cuando se utiliza en el producto, avisa 
al usuario de la presencia de importantes instrucciones de uso 
y mantenimiento recogidas en la documentación proporcionada 

con el equipo.

Para obtener información sobre directrices de seguridad, cumplimiento 
de normativas, compatibilidad electromagnética, accesibilidad y temas 
relacionados, consulte la Guía de cumplimiento de normativas y seguridad de 
Extron, referencia 68-290-01, en el sitio Web de Extron, www.extron.es.

Chinese Simplified（简体中文）

警告： 产品上的这个标志意在警告用户该产品机壳内有暴露的危险 

电压，有触电危险。

注意： 产品 上 的 这个标 志意在 提 示用户设备 随 附的用户手 册 中有 
重要的操作和维护(维修）说明。

关于我们产品的安全指南、遵循的规范、EMI/EMF 的兼容性、无障碍 

使用的特性等相关内容，敬请访问 Extron 网站 www.extron.cn，参见 Extron  

安全规范指南，产品编号 68-290-01。

Chinese Traditional（繁體中文）

警告: 若產品上使用此符號，是為了提醒使用者，產品機殼內存在著 

可能會導致觸電之風險的未絕緣危險電壓。

注意	  若產品上使用此符號，是為了提醒使用者。

有關安全性指導方針、法規遵守、EMI/EMF 相容性、存取範圍和相關主題的詳細
資訊，請瀏覽 Extron 網站：www.extron.cn，然後參閱《Extron 安全性與法規遵

守手冊》，準則編號 68-290-01。

Japanese

警告: この記号  が製品上に表示されている場合は、筐体内に絶縁されて 
  いない高電圧が流れ、感電の危険があることを示しています。

注意:	この記号  が製品上に表示されている場合は、本機の取扱説明書に	
	 記載されている重要な操作と保守(整備)の指示についてユーザーの

	 	 注意を喚起するものです。

安全上のご注意、法規厳守、EMI/EMF適合性、その他の関連項目に  
ついては、エクストロンのウェブサイトwww.extron.comより  

『Extron Safety and Regulatory Compliance Guide』 (P/N 68-290-01) をご覧ください。

Korean

경고:    이 기호 , 가 제품에 사용될 경우, 제품의 인클로저 내에 있는 
접지되지 않은 위험한 전류로 인해 사용자가 감전될 위험이 있음을 
경고합니다.

주의:     이 기호 , 가 제품에 사용될 경우, 장비와 함께 제공된 책자에 나와 
있는 주요 운영 및 유지보수(정비) 지침을 경고합니다.

안전 가이드라인, 규제 준수, EMI/EMF 호환성, 접근성, 그리고 관련 
항목에 대한 자세한 내용은 Extron 웹 사이트(www.extron.co.kr)의 
Extron 안전 및 규제 준수 안내서, 68-290-01 조항을 참조하십시오. 

Safety Instructions

www.extron.com
www.extron.fr
www.extron.de
www.extron.es
http://www.extron.cn
www.extron.cn
www.extron.com
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FCC Class A Notice
This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to part 15 of the FCC rules. The Class A limits provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause interference; the user must correct the interference at 
his own expense.

NOTE:	 For more information on safety guidelines, regulatory compliances, EMI/EMF compatibility, 
accessibility, and related topics, see the “Extron Safety and Regulatory Compliance 
Guide” on the Extron website.
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Trademarks
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Registered Trademarks (®)
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Document Conventions Conventions Used in this Guide

Notifications
The following notifications are used in this guide:

DANGER:	 A danger indicates a situation that will result in death or severe injury. 

WARNING:	 A warning indicates a situation that has the potential to result in death or 
severe injury. 

CAUTION:	 A caution indicates a situation that may result in minor injury.

ATTENTION:	 Attention indicates a situation that may damage or destroy the product or 
associated equipment. 

NOTE:	 A note draws attention to important information.

TIP:	 A tip provides a suggestion to make working with the application easier.

Software Commands
Commands are written in the fonts shown here: 

^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C

[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

E X! *X1&* X2)* X2#* X2! CE}

NOTE:	 For commands and examples of computer or device responses mentioned 
in this guide, the character “0” is used for the number zero and “O” is the capital 
letter “o.”

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

C:\Program Files\Extron

Variables are written in slanted form as shown here:
ping xxx.xxx.xxx.xxx —t

SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.
Click the OK button.

Specifications Availability
Product specifications are available on the Extron website, www.extron.com.

http://www.extron.com
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Introduction 

This section describes this manual and the DMP 64, including:

•	 About This Guide

•	 About the DMP 64 Digital Matrix Processor

•	 Features

•	 DMP 64 Application Diagram

About This Guide
This guide contains installation, configuration, and operating information for the 
Extron Electronics DMP 64 ProDSP™ Digital Matrix Processor, software-controlled digital 
audio processor. 

In this guide, the DMP 64 can also be referred to as “the mixer” or “device.”

About the DMP 64 Digital Matrix Processor
The DMP 64 is a standalone audio matrix processor with six microphone/line inputs and 
four line outputs. Using high-quality 24‑bit A/D converters sampling at 48kHz, input signals 
are converted into the digital domain where Digital Signal Processing algorithms process 
and mix the signals using Extron floating point ProDSP™ technology. The DMP 64 uses 
a dual‑matrix design providing virtual processing busses, with audio signal processing 
available in any of the input, virtual, and output signal paths. A dual matrix mixer with virtual 
paths provides extremely flexible architecture, allowing for versatile processing, mixing, and 
routing scenarios. 

The DMP 64 is IP Link®-enabled, connecting to a host computer via the Ethernet port for 
fast configuration and setup. Dual RS-232 ports on the rear panel, plus a USB port located 
on the front panel provide convenient high-speed access. Six digital I/O ports permit 
connection of switches and sensors to provide input to the system for triggering a variety of 
actions within the device. 

The DMP 64 has no front panel controls therefore, all configuration is performed using 
the Extron DSP Configurator™ program from a host computer connected by any of the 
communication ports: RS-232, USB or Ethernet. Signal present and clip LEDs for the six 
input channels and four output channels are provided on the front panel.

Two operational modes, Live and Emulate, allow a user to work offline from the device to 
set up a configuration and create presets and group controls as needed before placing the 
configuration in the DSP 64. DSP Configurator settings developed offline can be saved to 
disk as a job file to be uploaded to the device at a later time, or can be transferred directly 
to the device by switching to Live mode. Up to 32 full or partial presets and up to 32 group 
master controls can be created, loaded into, and stored in the DMP 64. The presets and 
controls can then be recalled through DSP Configurator, or a control system using Simple 
Instruction Set (SIS™) commands. Control systems connected to the device either by RS-
232 or Ethernet can control a limited subset of DMP 64 functions using SIS commands.
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Features
•	 Consumer and professional audio compatibility —� Input and output line level can 

be set to consumer (–10 dBV) or professional (+4 dBu).

•	 Inputs —� Six balanced or unbalanced mic/line on 3.5 mm, 3-pole captive screw 
connectors.

•	 Outputs —� Four balanced or unbalanced on 3.5 mm, 3-pole captive screw 
connectors. 

•	 ProDSP™ audio signal processing — Features 32- and 64-bit floating point 
audio DSP processing providing wide dynamic range and maintaining audio signal 
transparency while preventing DSP signal clipping and simplifying management of 
gain staging. 

•	 Pro-grade hardware — Studio grade 24-bit, 192 kHz analog-to-digital and 
digital-to-analog converters sampling at 48 kHz. 

•	 Low latency DSP processing — The DSP engine supports a large array of 
concurrent audio processing within an audio channel and across multiple channels, 
while maintaining extremely low latency from input to output. 

•	 DSP Configurator software — Powerful, user-friendly PC-based software tool 
for managing all audio operations of the DMP 64. Enables complete setup and 
configuration of digital audio processing tools on the ProDSP platform, as well as 
routing and mixing. 

•	 Intuitive graphical user environment — The DSP Configurator Software features 
a Graphical User Environment with a clear view of all input and outputs, audio 
processing blocks, routing, mix points, and virtual routing in a single window. This 
allows a designer or installer to quickly view all audio activities without having to 
access multiple windows or menus. 

•	 SpeedNav keyboard navigation — SpeedNav enables user-friendly, keyboard-
based navigation of the DSP Configurator Software without the need for a mouse 
or touchpad. Using keyboard navigation keys and shortcuts, a user can access any 
input or output, mixing points, and all audio DSP tools. Using only the keyboard for 
software access can help expedite audio system setup and commissioning while 
on‑site using laptop PCs. 

•	 Copy and paste for processing blocks — To help speed audio system design 
and setup, parameter settings can be quickly copied between individual processing 
blocks or identical groups of blocks within the Graphical User Environment, using 
conventional cut-and-paste commands. 

•	 32 DSP Configurator presets — Using the DSP Configurator software, parameters 
for DSP processing, signal levels, or audio routing can be saved as presets. These 
settings can be saved for the entire system, or any selected group of inputs, outputs, 
mixing points, and DSP blocks. 

•	 Six digital I/O ports for remote control or feedback — Six configurable digital I/O 
ports are provided that enable the DMP 64 to sense and respond to external triggers 
such as mic activation and muting. 

•	 Dual matrix design — The DMP 64 employs a dual matrix design with substantial 
flexibility to rout, mix, and process audio input sources. A primary matrix routes each 
input to any or all four outputs. If desired, any of the six inputs can first be directed 
into a secondary matrix, which routes the inputs to four virtual buses before being 
mixed back to the outputs via the primary matrix. Virtual buses allow for inputs to be 
grouped together and then processed with the same DSP settings and parameters, 
simplifying system setup and control. 
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•	 Group masters — The DMP 64 provides the capability to consolidate gain or mute 
control throughout the system. Any gain or mute block within the Graphical User 
Environment can be selected and added to a group master, which can then be 
controlled by a single master fader and mute control. Each group master can have up 
to 16 blocks, and up to 32 group masters can be created. 

•	 Soft limits — Soft limits can be applied to group master faders. Minimum and 
maximum limits can be specified and controlled via RS-232 serial control. 

•	 Source signal presence and clipping LEDs — The DMP 64 provides indicator 
LEDs on the front panel for each input and output providing real-time monitoring of 
signal presence. A separate set of LEDs illuminates as a warning when signal clipping 
is detected. 

•	 Flexible control options — The DMP 64 can be controlled using the DSP 
Configurator Software and a PC connection to the IP Link Ethernet port, the RS-232 
serial port, or the USB 2.0 port on the front panel. 

•	 Front panel USB configuration port — Enables configuration without having to 
access the rear panel. 

•	 RS-232 serial control port — Using serial commands, the DMP 64 can be 
controlled and configured via the Extron Windows®-based control program, or 
integrated into third-party control systems using Extron Simple Instruction Set (SIS™) 
commands. With two RS-232 serial ports plus the IP Link Ethernet port, the DMP 64 
offers possibilities for control in single and divisible room applications.

•	 Two RS-232 ports — The DMP 64 is equipped with both primary and secondary 
RS‑232 serial ports for divided room applications. 

•	 IP Link® Ethernet monitoring and control — Engineered to meet the needs 
of professional A/V environments, IP Link enables the DMP 64 to be proactively 
monitored and managed over a LAN, WAN, or the Internet, using standard TCP/IP 
protocols. 

•	 Versatile mounting options — Rack-mountable 1U, half rack width metal 
enclosure. 

•	 Universal power supply — The 100-240 VAC, 50-60 Hz, international power supply 
provides worldwide power compatibility.  
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DMP 64 Application Diagram
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Installation 

This section describes the installation of the DMP 64, including:

•	 Mounting the DMP 64

•	 Rear Panel Features and Cabling

Mounting the DMP 64
The 1U high, half rack width, 9.5 inch deep DMP 64 Digital Matrix Processor can be:

•	 Set on a table, 

•	 Mounted on a rack shelf, 

•	 Mounted under a desk or tabletop, or 

•	 Mounted on a projector bracket.

For detailed mounting options and UL rack mounting guidelines (see Mounting the 
DMP 64 on page 139).

Rear Panel Features and Cabling
DMP 64
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Figure 1. DMP 64 Rear Panel

NOTE:	 Control signal ground pins may be labeled as  or “G”. Audio ground pins may 
be labeled as  or .  
The wiring and function are the same, whichever way your product is labeled.
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a	 Power connector — Connect the included 12 VDC external power supply into the 
2-pole 3.5 mm captive screw connector. Be careful to observe the correct polarity.

SECTION  A–A

Power Supply
Output Cord

Ridges

A

Smooth

A

Ridges

Smooth

2-Pole Orange
Captive Screw

Connector
(12V)

T
ie

 W
ra

p

3/16”
(5 mm) Max.

Figure 2. Power Supply Wiring

Use the supplied tie-wrap to strap the power cord to the extended tail of the connector. 

ATTENTION:	

•	 The two power cord wires must be kept separate while the power supply is 
plugged in. Remove power before wiring.

•	 Always use a power supply specified by Extron Electronics for the DMP 64. Use 
of an unauthorized power supply voids all regulatory compliance certification and 
may cause damage to the supply and the DMP 64.

•	 When connecting the power supply, voltage polarity is extremely important. 
Applying power with incorrect voltage polarity could damage the power supply 
and the DMP 64. Identify the power cord negative (ground) lead by the ridges on 
the side of the cord or a black heat shrink wrapping around it.

•	 Unless otherwise stated, the AC/DC adapters are not suitable for use in air 
handling spaces or in wall cavities. The power supply is to be located within the 
same vicinity as the Extron AV processing equipment in an ordinary location, 
Pollution Degree 2, secured to the equipment rack within the dedicated closet, 
podium or desk.

•	 The installation must always be in accordance with the applicable provisions of 
National Electrical Code ANSI/NFPA 70, article 75 and the Canadian Electrical 
Code part 1, section 16. The power supply shall not be permanently fixed to 
building structure or similar structure.

NOTES:	

•	 The length of the exposed (stripped) copper wires is important. The ideal length 
is 3/16 in (5 mm). Longer bare wires can short together. Shorter wires are not as 
secure in the direct insertion connectors and could be pulled out.

•	 Do not tin the stripped power supply leads. Tinned wires are not as secure in the 
captive screw connectors and could be pulled out.

•	 To verify the polarity before connection, check the no load power supply output 
with a voltmeter.

•	 To avoid losing adjustments when configuring the DMP 64 via SIS commands, 
issue a 2FF or if using the Extron DSP Configurator, select Tools > Save 
changes to device to store the latest changes to the device. Wait several 
minutes after saving the adjustments before disconnecting power. 
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b	 Mic/Line 1-6 input connectors — 3-pole 3.5 mm double-stacked captive screw 
connectors accept balanced or unbalanced mono mic or line level signals. Mic/line 
inputs provide gain settings to accommodate consumer (–10 dBV) and professional 
(+4 dBu) operating line level sources, plus microphone level sources. Up to six mono 
microphones or line inputs, balanced and unbalanced in any combination can be 
connected to these inputs. See the following diagram for wiring instructions.

" (5 mm) MAX. (typ)3
16

Unbalanced Output

Tip

Sleeve
NO Ground Here

Balanced Output

Tip

Sleeve
Ring

ATTENTION: For unbalanced audio, connect the sleeve to 
the ground contact. 
DO NOT connect the sleeve to the negative (−) contacts.

Audio INPUT Wiring
Balanced Input

Sleeve
Ring

Tip Tip
Sleeve

Jumper
Unbalanced Input

" (5 mm) MAX. (typ)3
16

Figure 3. Balanced or Unbalanced Mic and Line Input Wiring

c	 Phantom Power indicators — These green LED indicators light when +48 V 
phantom power is placed on the corresponding mic/line input. Phantom power is not 
adjustable.

ATTENTION:	

•	 Condenser microphones require phantom power. Dynamic microphones do 
not require power. 

•	 Never set an unbalanced dynamic microphone to 48 V. Doing so can 
damage the microphone. For condenser mics, verify the microphone will 
safely operate at +48 VDC.

d	 Mono output connectors — 3-pole 3.5 mm captive screw connectors provide 
balanced or unbalanced connections for mono line level output signals.

" (5 mm) MAX. (typ)3
16

Unbalanced Output

Tip

Sleeve
NO Ground Here

Balanced Output

Tip

Sleeve
Ring

ATTENTION: For unbalanced audio, connect the sleeve to 
the ground contact. 
DO NOT connect the sleeve to the negative (−) contacts.

Audio INPUT Wiring
Balanced Input

Sleeve
Ring

Tip Tip
Sleeve

Jumper
Unbalanced Input

" (5 mm) MAX. (typ)3
16

Figure 4. Output Connector Wiring
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e	 Digital I/O output connectors — A double-stacked 4-pole 3.5 mm captive screw 
connector provides six configurable digital input or output ports allowing connection 
to various devices such as motion detectors, alarms, lights, LEDs, buttons, photo 
(light) sensors, or temperature sensors. 

	 Digital I/O ports are used to monitor or drive TTL level digital signals. The inputs 
can be configured to operate in one of two modes: digital input or digital output. 
In OUTPUT mode, the device can source up to 250 mA at +5 V. In INPUT mode, 
voltages greater than 1 V indicate a logic 'high' signal while voltages less than 1 V 
indicate a logic 'low'.

	 All digital I/O ports are tied to a common ground (one common ground for each 
4-pole connector), but can be individually configured to operate in one of two modes: 
digital input or digital output. 

NOTE:	 These ports can be configured via the DSP Configurator (see Digital I/O 
Ports on page 75 for additional information).

Do not tin the wires!

(5 mm) MAX. 3 "
16  

-or-

1
2
3
_

4
5
6
_

Figure 5. Digital I/O Wiring

f	 RS-232 connector — Two stacked 3-pole 3.5 mm captive screw connectors, 
labeled RS-232 (1) and RS-232 (2), are available for bi-directional RS-232 (±5 V) serial 
control. Default baud rate is 38400. 

Receive (Rx)
Transmit (Tx)

Ground (    )

Bidirectional

RS-232
Device

Ground (    )
Receive (Rx)
Transmit (Tx)

RxTx

Do not tin
the wires!

Figure 6. RS-232 Wiring

g	 LAN (RJ-45) connector — A standard RJ-45 jack accepts an RJ-45 plug for 
Ethernet connection.

•	 A yellow (ACT) LED indicates data activity on the connection.

•	 A green (Link) LED indicates the jack is connected properly to the network. 
See SIS Programming and Control on page 92 for additional information on 
Ethernet cabling.

h	 Reset button — The reset button is used to return the DMP 64 to different tiers of 
default states and to place the unit into an event recording mode for troubleshooting   
(see DMP 64 Hardware Reset Modes on page 138).

USB Configuration Port (Front Panel)
A front panel configuration port uses an Extron USB A Male to USB Mini B Male 
Configuration Cable (part number 26-654-06) for connection to a PC computer and the 
USB port (see Install the USB Driver on page 17 for USB driver installation details).
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Hardware 
Operation

This section describes the the operation of the DMP 64, including:

•	 DMP 64 Operation

•	 Front Panel Operation

•	 Rear Panel Operation

DMP 64 Operation
The DMP 64 does not have physical controls. Configuration and operation are 
accomplished using a PC running Windows XP or newer and the DSP Configurator 
software (available on the included disc or at www.extron.com), an embedded web 
page using Windows Internet Explorer, or the Extron Simple Instruction Set (SIS™) using 
hyper‑terminal or DataViewer. 

The DMP 64 has several front and rear panel operational indicators described in the 
following pages.
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Front Panel Operation

DMP 64
DIGITAL MATRIX PROCESSOR

INPUTS

CLIP

SIGNAL
1 2 3 4 5 6

CONFIG

OUTPUTS

CLIP

SIGNAL
1 2 3 4

b c da

Figure 7.	 DMP 64 Front Panel

a	 Power LED — The power indicator lights when the DMP 64 is operational. 

b	 Configuration connector — The USB 2.0 port uses a mini type-B connector to 
connect to a host computer for control. The DMP 64 USB driver must be installed 
prior to using the port (see Install the USB Driver on page 17). 

The DMP 64 appears as a USB peripheral with bi-directional communication. The 
USB connection can be used for software operation (see Windows-based Program 
Control on page 15), and SIS control (see Software Control on page 14).

c	 Input Indicators — Stacked red (signal clipping) and green (signal present) LEDs for 
inputs 1 – 6 . Each column represents one input channel.

The green signal LED varies in brightness corresponding to the real-time input signal 
level. It begins to light at – 60 dBFS increasing in fifteen steps to full intensity as the 
signal level increases. When the signal reaches – 3 dBFS or above, the red clipping 
LED lights and remains lit as long as the signal remains above – 3 dBFS. When it falls 
below that level, the red LED remains lit for 200 milliseconds, after which the display 
resumes real‑time monitoring of the signal level.

d	 Output Indicators — Stacked red (signal clipping) and green (signal present) LEDs 
for outputs 1 through 4. Each LED column represents one output channel.

The green signal LED varies in brightness corresponding to the output signal level. It 
begins to light at – 60 dBFS increasing to full intensity corresponding to signal level 
increases. When the signal level reaches – 3 dBFS or above, the red clipping LED 
lights and remains lit as long as the signal remains above – 3 dBFS. When it falls 
below that level, the red LED remains lit for 200 milliseconds, after which the display 
resumes real‑time monitoring of the signal level.
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Rear Panel Operation
DMP 64
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Figure 8.	 DMP 64 Rear Panel

a b d e f	See Rear Panel Features and Cabling on page 5 for details.

c	 Phantom Power indicators (MIC +48V) — These green LED indicators light solid 
when +48 V phantom power is placed on the corresponding mic/line input. Phantom 
power is not adjustable.

ATTENTION:	

•	 Condenser microphones require phantom power. Dynamic microphones do 
not require power.

•	 Never set an unbalanced dynamic microphone to +48V. Doing so can 
damage the microphone. For condenser mics, verify the mic will safely 
operate at +48 VDC.

•	 When a line level source is connected, be certain the +48V phantom power 
is off (unchecked).

g	 LAN — The LAN connector has a green LED that lights solid to indicate proper 
connection to an active LAN and a yellow LED that blinks to indicate data activity.

h	 Reset — The reset actuator initiates system resets (see Reset Actuator and LED 
Indicator on page 12).

i	 Power/Reset LED — The green LED indicator adjacent to the reset button 
duplicates the front panel LED operation (see Reset Actuator and LED Indicator 
on page 12).

Power Cycle
Current mixing and audio processor settings (the current state of the device) are saved 
in nonvolatile memory. When the unit is powered off, all settings are retained. When the 
unit is powered back on, it recalls settings from the nonvolatile memory. If a configuration 
was in process during the power down, these saved mix, audio level, and audio DSP 
processor settings become active.

On power up the unit performs a self-test. The front and rear power indicator LEDs flash 
during the test, then light solid when the unit is available for operation or programming. 

Firmware Updates
The firmware of the DMP 64 can be updated through Ethernet, USB, or RS-232 
connection. The user can obtain new firmware from the Extron website, or from an Extron 
Applications Engineer via e-mail. After obtaining the new firmware, upload it to the unit 
via the served web pages (see HTML Operation on page 120), using the Firmware 
Loader in the DSP Configurator program (see DMP Software on page 14), or using 
the Extron standalone Firmware Loader software application available on the included disc 
or at www.extron.com.
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Reset Actuator and LED Indicator
A recessed button (h) on the rear panel initiates several reset modes. The rear panel LED 
(i) blinks to indicate the reset mode. 

DMP 64

POWER
12V         
1.0A MAX RESET

LAN
1 2 3

4 5 6

4 5 6

1 2

3 4

Tx Rx  G

RS-232 (2)
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4 5 6   G

1 2 3   G
MIC
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1 32

M
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E
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T
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T
P

U
T

S

I/O

R
E
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O

T
E

Rear Panel

h i

Figure 9.	 Reset button and LED

Hardware Reset Modes:

NOTE:	 The reset modes listed below will close all open IP and Telnet connections, 
and close all sockets. 

The reset modes have separate and distinct functions. Additional information is available 
(see DMP 64 Hardware Reset Modes on page 138). 

Each reset LED flash lasts for 0.25 seconds. 

MODE 1 — Firmware reset:  

1.	 Disconnect power to the DMP 64. 

2.	 Press and hold the reset button.

3.	 Apply power to the device while holding the reset button.

Mode 1 will:

•	 Return the firmware to the version shipped with the unit from the factory. This 
allows recovering a unit with incorrect or corrupt firmware. 

•	 Maintain all user files and settings. 

NOTE:	 Some user web pages may not work correctly if returning the unit to an 
earlier firmware release.

MODE 3 — Events reset:  

1.	 Apply power to the DMP 64.

2.	 Press and hold the reset button until the reset LED blinks once (~3 seconds). 
Release the reset button, 

3.	 Within one (1) second press the reset button again to toggle events on or off, 
depending on the current state.

•	 If event logging is currently stopped, following the momentary (<1 sec.) press, 
the reset LED will flash twice indicating events logging has started.

•	 If any events are currently running, following the momentary press, the reset 
LED will flash three times indicating that events logging has stopped. 

If a momentary press does not occur within 1 second, the events logging status 
before entering reset will remain.
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MODE 4 — IP Address reset:  

1.	 Apply power to the DMP 64.

2.	 Press and hold the reset button about 6 seconds until the reset LED blinks twice. 
Release the reset button.

3.	 Within (1) second, press the reset button again to reset the IP settings. 

If a momentary press does not occur within 1 second, the reset will be ignored.

Mode 4 will:

•	 Enable ARP program capability

•	 Set the IP address back to factory default (192.168.254.254)

•	 Set the Subnet back to factory default (255.255.0.0)

•	 Set the Gateway back to factory default (0.0.0.0)

•	 Set the Digital I/O Port mapping back to factory default

•	 Turn DHCP off

•	 Turn Events logging off

MODE 5 — Factory default reset:  

1.	 Apply power to the DMP 64.

2.	 Press and hold the reset button until the reset LED blinks 3 times (~9 seconds), 
then release. 

3.	 Momentarily (<1 second) press the reset button to return the DMP 64 to factory 
default conditions. 

If a momentary press does not occur within 1 second, the reset is exited. 

The default (reset) state of the device is:

•	 All mix-points set to 0 dB gain and muted.

•	 All outputs active (unmuted, 100% volume).

•	 No inserted or active DSP processing.

•	 All audio inputs are set to 0 dB gain and muted. 

•	 All preset and group master memory is clear (empty).

Digital I/O Ports
The dual 4-pin Digital I/O ports monitor or drive TTL level digital signals. The ports consist 
of two banks of three I/Os with the fourth pin used as a ground, providing six ports total. 
The DSP Configurator software provides selection from a list of scripts, that can be loaded 
to the DMP 64. The scripts provide pre‑configured sets of functions. 

From the main structure menu, click Tools > Configure Digital IO to access the scripts 
(see Digital I/O Ports on page 75).
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DMP Software

This section describes the control software for the DMP 64, including:

•	 Software Control

•	 Embedded Web Pages

•	 Windows-based Program Control

•	 DSP Configurator Program Basics

•	 Audio level, Mix-point, Processing Blocks, and Signal Chains

•	 Mic/Line Input Signal Controls

•	 Ducker Tutorials

•	 Line Output Channels

•	 Virtual Bus Returns

•	 Primary Mix Matrix

•	 Secondary Mix Matrix

•	 Group Masters

•	 Digital I/O Ports

•	 Emulate Mode and Live Mode

•	 Presets

•	 Protected Configuration

•	 DSP Configurator Windows Menus

•	 Optimizing Audio Levels

Software Control
The DMP 64 can be controlled using the DSP Configurator software, SIS commands 
through hyper terminal or DataViewer, or using embedded WebPages. IP Link functions 
will be available through network connection including global viewer functionality. 

The DMP 64 has the following connection options:

•	 RS-232 — One single stack 3-pole, 3.5 mm captive screw connector is used for 
bi‑directional RS-232 (±5 V) serial control.

See Rear Panel Features and Cabling on page 5, for additional details on 
connecting the RS‑232 port.

•	 LAN — 10 Mbps, 100 Mbps, half duplex, full duplex connections are supported. Two 
LEDs indicate connection and activity status. The device has the following default 
Ethernet configurations:

IP Address: 192.168.254.254 Default Gateway:  0.0.0.0

Subnet Mask: 255.255.0.0 DHCP: OFF

See Rear Panel Features and Cabling on page 5, and Connection Options 
on page 92 for additional details on connecting the LAN.

•	 USB 2.0 — A Mini B-type USB connector located on the front panel provides 
high‑speed USB 2.0 connectivity to a host computer, backward compatible to 1.0.
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Embedded Web Pages
The embedded web pages, accessible by LAN using a web browser, include the following 
information, available in a tabbed interface.

•	 System Status — The opening web page, displaying a report of system status 
parameters. 

•	 Configuration — This tab contains the following menu items.

•	 System Settings. Contains IP address and date/time settings.

•	 Passwords. Enter/re-enter admin and user password fields to set up password 
protected access.

•	 Firmware Upgrades. Browse/upload firmware to the device.

•	 File Management — Delete or upload files

•	 Control — Contains the following menu items:

•	 Audio Settings. Includes mix matrix, input and output gain control.

•	 Group Controls. Provides access-only to the group controls.

•	 Presets. Used to save new presets created on Audio Settings page.

See HTML Operation on page 120 for further details.

Windows-based Program Control
The DSP Configurator Control Program is compatible with Windows 2000, Windows XP, 
and Vista, and provides remote control of the input gain/attenuation, output volume 
output adjustment, and other features.

DSP Configurator can control the DMP 64 using any of the three control ports, RS‑232, 
USB, or LAN.

Updates to this program can be downloaded from the Extron website at 
www.extron.com.

Installing the DSP Configurator Program
The program is contained on the Extron Software Products disk. 

Install the software as follows:

1.	 Insert the disk into the drive
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2.	 Click the Software tab or software icon.

NOTE:	 If the DVD setup program does not start automatically, run Launch.exe 
from the DVD ROM directory using Windows “My Computer”.

Figure 10. DVD Software Menu

3.	 Scroll to the DSP Configurator program and click the Install text to its right.

Figure 11. DVD Control Software Menu

4.	 Follow the on-screen instructions. By default, the installation creates a 
C:\Program Files\Extron\DSP_Configurator folder for the DSP Configurator 
program.

5.	 When the DSP Configurator installation is complete, the USB Installer starts 
automatically (see Install the USB Driver on page 17). Extron recommends the 
USB drivers be installed whether they are used immediately or not.
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Install the USB Driver
When the USB installer begins, follow these instructions.

1.	 When the driver installation window appears (see figure 12), click Next to proceed.

Figure 12.	 USB Installer Splash Screen

2.	 The driver installer launches (see figure 13). 

Figure 13.	 USB Driver Installation
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3.	 When the installer has completed the installation of the USB drivers, the following 
screen appears (see figure 14):

Figure 14. Successful USB Driver Installation

4.	 Click Finish.

USB driver installation is complete.

DSP Configurator Program Basics

Starting the Program

NOTE:	 Extron recommends connection via the Ethernet LAN port for running the 
DSP Configurator program.

To run the DSP Configurator Program, click  
Start > Programs > Extron Electronics > DSP Configurator > DSP 
Configurator. 

The DSP Configurator program starts in Emulate mode (see figure 15, next page). Also 
(see Emulate Mode and Live Mode on page 76) for details of mode operation.

Using the Program
In Emulate mode, audio parameters can be selected, then transferred to the DMP 64 
by switching to Live mode (while connected to a DMP 64). Audio settings can also be 
tailored while connected to the DMP 64 which allows real-time auditioning of the audio 
output as adjustments are made (see Emulate Mode and Live Mode on page 76).
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Figure 15.	 DMP 64 Configurator Program

The DSP Configurator program window consists of an input and virtual return signal 
processor chain, the main mixer, virtual send and receive (secondary) mixers, and an 
output signal processing chain.

a	 Mic/Line Input Gain control f	 Output signal processor chain

b	 Mic/line input signal processor chain g	 Output volume control

c	 Mic/Line input pre-mixer gain h	 Virtual Bus signal processor chain

d	 Primary Mix-points i	 Virtual Bus Return (primary) mix-points

e	 Output trim control (post-mixer trim) j	 Virtual Bus Send (secondary) mix-points
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Navigation
There are two methods of navigation around the interface: 

•	 Keyboard •	 Mouse

One element in the user interface always retains focus. When a new DSP Configurator file 
is opened, the upper left element (Input #1 Gain) is focused by default.

Keyboard Navigation

All user interface elements, including mix-points, have the ability to receive focus using 
the tab and arrow keys or using the arrow keys following a single left-click. For additional 
details (see Keyboard Navigation on page 85).

Mouse Navigation

Left-click. A single click brings focus to a processor block, as well as other interface 
elements such as tabs, sliders, check boxes. Other left-click actions follow the Windows 
standard.

Right-click. A single right-click brings up a context menu specific to the processor block 
right-clicked. Other right-click actions follow the Windows standard.

Double-click. A double-click opens a dialog window from either the focused or 
unfocused state of an element.

Cut, Copy, or Paste Functions
The user can cut, copy, or paste a processor. The actions can be performed from a:

•	 Context menu accessed by a right-click of the processor, 

•	 Using the Edit menu, 

•	 Using standard Windows keystrokes: 

•	 <Ctrl+X> = cut 

•	 <Ctrl+C> = copy 

•	 <Ctrl+V> = paste 

Multiple elements can be acted upon but the blocks copied must be compatible with 
the desired paste blocks. A highlighted group of elements can be cut or copied to a 
clipboard. The clipboard contents can then be pasted, but only succeeds if there is an 
exact one-to-one relationship between the clipboard contents and the block or blocks 
pasted. 

In the following example, the Mic #1 input signal path is copied to Mic #5. First, click the 
mouse and drag it across the entire signal path. The selected blocks are highlighted in 
green. Press <Ctrl+C>, or use the Edit > Copy menu selection to copy the blocks.
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As shown below, the starting point for the paste, (the upper, leftmost element), must first 
be focused by left-clicking the mouse on it. Note the green focus outline that appears on 
the Mic #4 Gain block. The clipboard elements are pasted using the context menu Paste 
command, the Edit>Paste command, or <Ctrl+V>.

NOTE:	 A cut and copy of elements can be pasted to multiple locations. To copy the 
clipboard to an additional location, click on the leftmost block and paste again. 

The program warns that all settings in the section being pasted to will be overwritten:

After clicking Yes, the entire Mic #4 input path is now identical to the Mic #1 input path 
including signal levels, parameter settings, and mute/bypass selections.

Any single processor block can be copied, then pasted to a similar processor block in the 
same or different input, virtual or output signal path. Mix-point gains can be copied from 
one to another; however, input gain, pre‑mixer gain, post-mixer trim, and output volume 
cannot. Mix‑point settings can be freely copied between mix-points. The user is always 
asked whether they want to overwrite the existing information. If an attempt is made to 
copy a processor block setting to an incompatible block, the user is advised the action 
cannot be completed.
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DSP Configurator Toolbar Menus
The DSP Configurator contains the following structural menus, arranged horizontally 
below the title bar:

File	

NOTE:	 New, Open, and Recent Files are unavailable in Live 
mode.

•	 New — Discards the current DSP configuration (after prompting to 
save any changes) and opens a blank configuration file.

•	 Open — Loads and activates a previously saved DSP 
configuration file.

•	 Save — Saves all changes to the current DSP configuration file 
under the current file name. If the file has not previously been 
saved, prompts for a file name.

•	 Save As — Saves all changes to the current DSP configuration 
file under a new file name.

•	 Backup — Transfers all partial presets plus the current configuration to a DSP 
configuration file within the DSP Configurator program.

•	 Recent Files — Opens a list of recently opened or saved DSP configuration files.

•	 Exit — Closes the DSP Configurator Program.

Edit	

•	 Cut — Removes all parameters of a selected 
processor block or set of selected blocks to the 
clipboard. If not followed by a Paste command to a 
different block, the parameters are restored.

NOTE:	 Processor blocks are not removed from the processor stream after a 
Cut and a subsequent Paste operation. Only the parameters are moved. 

	 Processor blocks and their parameters can be pasted only into another block of 
the same type. For example, the input 1 filter block and all of its parameters can 
be copied to the input 2 filter block but not to the input 1 delay block.

•	 Copy — Copies all of the parameters of a selected processor block, gain block, or 
set of selected blocks to the clipboard.

•	 Paste — Inserts processor blocks and their parameters from the clipboard into the 
selected location.
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View			 

•	 Meter Bridge — Opens a Meters dialog box with 
real-time meters that monitor signal levels at each 
input and output.

NOTE:	 Meter Bridge is available in Live mode only while connected using 
the LAN port.

Figure 16. Meter Bridge

•	 Re-enable all dialogs — Re-enables all dialog boxes, the pop-up windows 
that allow changes to block parameters.

•	 Error log — Lists error messages as a troubleshooting tool.

•	 Group Controls — Opens the Group Controls dialog box (see Group Masters on 
page 69).

Tools		

The Tools menu contains the following items and sub-menu:

•	 Presets — Provides three options:

•	 Mark All Items — Mark (select) all parts of the 
current configuration (excluding presets), including 
processors and mix-points to save as a partial preset.

•	 Save Preset — Save the currently marked 
processors, and mix-points as a partial preset.

•	 Clear Marked Items — Unmark (deselect) all parts 
of the current configuration (excluding presets), including 
processors and mix-points.

•	 Protected Configuration — Live mode only. Allows a user (typically the 
installer) to save and recall a protected configuration. The protected configuration 
is useful to establish parameters and values (with the exception of the device 
IP address) in a known state, either as a troubleshooting tool or as a baseline 
configuration. A protected configuration, once saved in the device, is always present 
and cannot be overwritten without entering a user-defined Personal Identification 
Number (PIN) password. The protected configuration is restored without a PIN.

NOTE:	 The default PIN is 0000.

•	 Save — Save the current configuration (excluding presets), including processors 
and mixes as a password protected configuration. The DSP Configurator 
program prompts for a PIN to save.

•	 Recall — Recall the protected configuration.

•	 Change PIN — Change the PIN associated with the protected configuration.
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•	 Configure Digital I/O Ports — Live mode only. Opens a utility to configure 
digital I/O ports. The DMP 64 provides six digital I/O ports that can be used to trigger 
external events from DMP 64 actions, or for external events to trigger DMP actions 
(see Digital I/O Ports on page 75).

•	 Connect to/Disconnect from Device (depending on Emulate or Live 
mode) — Performs the same functions as the Mode Emulate and Mode Live 
buttons.

•	 Issue RESET Command — Initializes and clears the following: mix-points, presets, 
processor blocks, and gain blocks. This reset is identical to the E ZXXX} SIS 
command (see SIS Programming and Control on page 92).

•	 Save changes to device — Live mode only. Saves configuration changes 
made in the DSP Configurator program to the DMP 64.

•	 Firmware Loader — Calls the Firmware Loader program, which allows updates 
without taking the DMP 64 out of service (see Firmware Loader on page 136).

•	 Configure Groups — Opens the configure groups dialog box (see Group 
Masters on page 69).

•	 Device Settings — Live mode only. Opens a dialog box providing a means to 
change the IP address, set administrator and user passwords, and select the serial 
port baud rate.

•	 Options — Opens a tabbed dialog box to customize the DSP Configurator 
appearance and operation.

•	 Colors — Tailor the appearance of 
the various graphs and dialog boxes. 
Appearance uses a selected color scheme 
for the complimentary and graph colors. 
Complimentary Colors allows custom 
selection of colors used with the various 
graphs and dialog boxes. Graph colors 
change the row colors containing the 
information and descriptions of the graphs 
seen in the processor blocks.

•	 Preferences — The startup splash screen contains options to select the 
device to connect to, or to “Always ask” on startup.  
The selection can be changed using Default Device. 

•	 If Show Meters is set to True, Dynamic 
Block Meters is used to tailor the 
appearance of the dynamics meters to 
use the full meter to show input and gain 
reduction, or to show the level based on the 
output and gain reduction. 
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•	 Processor Defaults, 
Reset All Defaults — 
Returns the DMP 64 processor 
and level control blocks to factory 
default settings. Each processor 
and gain/volume/trim block also 
has an individual default reset.

•	 Processor Defaults, Defaults 
— Individually selects the default 
parameters for the various 
processor, trim, and gain blocks. 

Each row item contains default 
settings customized for the 
processor, filter, trim, or gain block 
it represents. 

Gain and volume blocks can be 
initially muted, while filter and 
dynamics processor blocks can 
be initially bypassed. 

NOTE:	 The bypass function is labeled Enable.

•	 To view the individual processor defaults, press the + button on the name of the 
processor, trim, gain or meter device.

Window Menu	

•	 Cascade — Rearranges all open DSP Configurator program 
windows, including dialog boxes, in a cascading array.

•	 Close All Windows — Closes all open dialog boxes.

•	 Individual Windows — Brings the associated dialog box to the front of the desktop.

Help selection

The Help menu contains the following elements:

•	 Contents — Opens the Help file at the Contents tab.

•	 Search — Opens the Help file at the Search tab.

•	 About... — Displays the name of the application, the current version number, and 
copyright information. 

NOTE:	 Help can be activated by pressing the <F1> key from the main screen. 
When a dialog box is open the <F1> key opens context‑specific help. .
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Presets Drop-down
Displays a list of up to 32 presets. Select a preset from the list to 
display it in the window and either activate it (Recall), abort the 
selection without either recalling or deleting it (Cancel), or delete it 
(Delete).

NOTE:	 An asterisk in the drop-down list indicates a partial preset exists only in 
the DMP 64 and has not been uploaded to the DSP Configurator. 

Mode Buttons 
Provides selection between Live mode and Emulate mode. See 
Emulate Mode and Live Mode on page 76 for more information.

Backup

When in Live mode (connected to a DMP 64), if presets exist in the DMP 64 that are not 
present in the DSP Configurator program (indicated by an asterisk next to the preset 
name), the function halts and prompts the user to run a backup.

Backup (File>Backup) transfers all partial presets plus the current configuration from 
the DMP 64 to a DSP configuration (.edc) file within the DSP Configurator program and 
then displays a prompt to save the file to the hard drive. Backup is unavailable when the 
DSP Configurator program is in Emulate mode.
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Figure 17.	 Control Blocks and Processor Chains

Audio Level, Mix-point, Processing Blocks, and Signal Chains
Outlined in red above (see figure 17), all control blocks on the main DSP user interface 
have one of three main functions in the overall signal chain:

•	 Level control (gain, trim, and volume),

•	 Mix-point (signal routing), or

•	 Signal processing (filter, feedback, dynamics, delay, duck, and loudness).

The signal chain varies depending on whether it is in the input, output, or virtual bus stage. 
The input chain begins with a level control (GAIN), filter (FILT), feedback suppression 
(FBS), two dynamics (DYN) and a delay (DLY) processor, followed by ducking (DUCK) and 
a pre-mixer gain (GAIN) control. The output chain begins with a level control (post-mixer 
trim [TRIM]), loudness (LOUD), delay (DLY), filter (FILT), and dynamics (DYN) processing 
blocks, and an output volume control (VOL). Each virtual bus chain has a filter (FILT), a 
dynamic processing block (DYN), loudness (LOUD), and output trim control (GAIN). All 
mix-points have a gain control. 

Each of the three signal processing chains; Input (a, b, c), Output (e, f, g), 
and Virtual (h) (see figure 17), consist of a series of control blocks of two 
basic types specific to that chain: level control (gain, trim, and volume 
control), and signal processors (frequency filters, feedback suppression, dynamics, delay, 
ducking, and loudness). Both types of control blocks are always present in the chains. 
Gain controls default to unmuted and processor blocks are bypassed upon insertion. 

Gain, trim and volume blocks can be muted and processor blocks (after being inserted) 
can be bypassed for signal comparison. Mutes and bypasses are shown by a red 
indicator in the lower left of the block.

Figure 18.	 Input Gain Control Muted, Dynamics Processor Bypassed
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Level Control Blocks
To access a gain, trim or volume control to view a setting, make a change, or observe a 
live audio meter (input gain and output volume blocks only), double‑click the gain block 
icon (see figure 19). This action opens a dialog box that contains the fader for that control.

A dialog box opens,
containing the full 
fader control. 

NOTE: In Emulate mode (the 
startup mode), the meter is 
not operational.

Double-click a gain, 
trim, or volume control.

Figure 19.	 Accessing a Typical Gain Control Dialog Box

Processor Blocks
Each processor block represents a menu of one or more processors that can be inserted 
into the audio stream. For blocks that provide more than one processor, only one can be 
selected. Each block can be inserted by a double-click or right-click>Insert then selecting 
the desired processor (see figure 20). When a block is inserted, the selected processor 
is displayed in the block and the block changes color. Processor blocks default to 
bypassed. To have them default to “not bypassed,” see Tools on page 23.

Double-click the
processor block. 

Click the desired 
processor.

The selected processor is displayed in the 
block.
To change processor variables, double-click the 
block again to open the processor dialog box.-or- 

Right-click the
processor block. Click insert.

Click to select the 
desired processor.

Figure 20.	 Selecting a Processor Block
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Once a processor is inserted, to view associated parameters that define the selected 
processor (such as a frequency curve) or to remove the bypass, double‑click on the 
processor block. This action opens a new window with a dialog box that contains 
parameters for the processor (see figure 21).

Figure 21.	 Sample Processor Dialog Box

•	 The Set Defaults button discards all custom settings and	  
reloads the default parameters.

•	 The Bypass button temporarily suspends the processing without	  
without removing the processor block. Red indicates the processor is 
bypassed.

By default, each processor block is bypassed when inserted (the Bypass button in the 
processor dialog box is red). This can be changed for each processor block type, see 
Tools>Options and the specific defaults for the processor types. 

NOTE:	 Figure 21 is an example of one type of dialog box. Contents and appearance 
of each dialog box are unique to the processor type.

The block can be removed from the signal chain by selecting it with a single mouse click 
and pressing the keyboard <Delete> key or by right-clicking and selecting Delete.
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Mic/Line Input Signal Controls

The input signal processor chain allows adjustments to program or microphone audio 
material before input to the main mixer.

Gain Control (GAIN) 
The gain control provides a single long-throw fader with a range of –18 dB to +80 dB, 
adjustable in 1 dB increments with the fader, or in 0.1 dB increments using direct entry 
in the input signal level readout below the fader. The 
peak reading meter holds the peak level for one second, 
displaying it numerically in the box below the meter. The 
default setting is unity gain (0.0 dB).

The Phantom Power checkbox, accessible in the 
dialog box, toggles the +48 VDC phantom power on 
and off. Phantom power is typically used to power a 
condenser microphone.

The Mute button, accessible in the dialog box, silences 
the input.

The Polarity button, accessible in the dialog box, 
allows the polarity of the wires connected to the audio 
connectors (+/tip and –/ring) to be flipped to correct for 
miswired connectors. 

Fader Handle

Input
Signal Level 

Readout
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Filter (FILT) 
Each filter block allows a total of five filters. The first filter is inserted from a processor list 
that appears when the block is double‑clicked or from a context window that shows a 
processor list when the block is right‑clicked. 

Figure 22.	 Insert Filter Menu

Once inserted, double‑click the processor block to change parameters of the filter. After 
the first filter is inserted, up to four additional filters can be added to the filter block using 
the dialog box. Select the desired filters from the following list using the drop‑down boxes:

•	 High pass filter — A high pass filter passes a band of frequencies extending from a 
specified cutoff frequency (greater than zero) up toward the high end of the frequency 
spectrum. All frequencies above the specified cutoff frequency are allowed to pass, 
while all frequencies below are attenuated.  
The default cutoff is 100 Hz.

•	 Low pass filter — A low pass filter passes a band of frequencies extending from a 
specified cutoff frequency (less than infinite) towards the lower end of the frequency 
spectrum. All frequencies below the specified frequency are allowed to pass, while all 
frequencies above are attenuated.  
The default cutoff is 10 kHz.

•	 Bass and treble filters — Also known as shelving or tone controls, the separate 
bass and treble filters provide the ability to cut or boost gain linearly above or below a 
specific frequency, with the end-band shape giving the visual appearance of a shelf.  
The bass default frequency is 100 Hz and the treble default is 8 kHz.

•	 Parametric equalizer filter — The parametric filter is a frequency equalizer that 
offers control of all parameters, including amplitude (the amount of gain/boost or 
gain reduction/cut applied), center frequency (frequency), and range of affected 
frequencies (Q) around the center frequency. 
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Figure 23.	 Filter Block Dialog Box

Additional filters are inserted using the open filter block dialog box, and selecting a filter 
type from the drop-down filter selection list. All filter parameters are modified using 
the Filter block dialog box. Each filter is loaded with all applicable default parameters 
displayed to the right of each drop-down filter selection list.
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Figure 24.	 Filter Dialog Box, Filters Added

Within the dialog box, a filter is focused when a filter type is inserted, or is focused by 
clicking the filter number to the left of the filter selection drop-down list. Note how box 3 
(see figure 24) is highlighted in yellow, indicating it is the filter in focus. When bypassed, 
the results of the filter in focus (independent of other filters) will show in the graph as a 
dotted line the same color as its filter row. When active (not bypassed), the line is solid. 

When multiple filters are enabled, the graph indicates the focused filter result (independent 
of other filters) in the color of the filter row in the type/parameters table below the graph. 
The composite response of all filters is displayed in red. 
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Figure 25.	 Filter Dialog Box, Filter Not Bypassed

Above the graph, each filter has a "handle" (circled in red above for the parametric 
EQ filter) placed directly above the cutoff or center frequency. The handle number 
corresponds to the filter number (also outlined in red). Clicking a handle or clicking the 
table row brings focus to that filter. <Click+hold+dragging> the handle horizontally 
changes the cutoff or center frequency to a new position on the x axis.

The table below shows each filter type with default parameter settings. The table 
immediately following shows the range for each parameter.

Type Frequency Parameter 1 Parameter 2

Parametric 1000.0 Hz Boost/Cut: 0.0 dB Q: 1.0

High Pass   100.0 Hz Slope: 6 dB N/A

Low Pass  10000.0 Hz Slope: 6 dB N/A

Bass (Tone)   100.0 Hz Boost/Cut: 0.0 dB Slope: 6 dB

Treble (Tone)   8000.0 Hz Boost/Cut: 0.0 dB Slope: 6 dB

Filter Parameter Settings Range

Frequency 20 Hz to 20 kHz

Tone (Boost/Cut) -24 dB to +24 dB

Q (Parametric EQ only) 0.707 to 15.000

Slope (HP & LP filters only) 1st Order (6 dB) and 2nd Order (12 dB)

 

DMP 64 • Software Control 34



High Pass

The high pass filter allows frequencies below the specified frequency to pass 
unattenuated. All frequencies below the cutoff are attenuated.

The default cutoff is 100 Hz.

Figure 26.	 High Pass Filter Response Curve

All frequencies lower than the specified frequency (in this example,100 Hz) are attenuated 
leaving the upper frequency response flat. Also note that at the specified frequency 
(100 Hz) the signal is 3 dB down, typical operation for high pass filters. The 3 dB down 
point will remain constant regardless of the slope setting. Only the steepness of the 
frequency attenuation curve changes.
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Low Pass

The low pass filter is the opposite of the High Pass filter. All frequencies above the 
specified frequency are attenuated allowing lower frequencies to pass. 

Figure 27.	 Low Pass Filter Response Curve

Here, the frequencies higher than the specified frequency, 10 kHz, are attenuated leaving 
the lower frequency response flat.
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Bass and Treble Shelving

Bass and treble shelving can be added to the filter. Also known as shelving or tone 
controls, the separate bass and treble filters provide the ability to cut or boost gain 
linearly above or below a selected frequency, with the end-band shape giving the visual 
appearance of a shelf. 

Adding the filter automatically inserts both a bass and a treble control row. If only a bass 
or only a treble filter is required, either bypass the unneeded control or set it to Unused in 
the selection box (see row 3, row 4, and row 5 in figure 28).

 

Figure 28.	 Bass and Treble Shelving

The corner frequency of the controls can be selected to 0.1 Hz accuracy. Two slopes, 
6 and 12 dB/octave are selectable along with the ability to boost or cut the signal up 
to 24 dB.
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Parametric (Equalizer)

The parametric filter is a frequency equalizer that offers control of all parameters, including 
amplitude (the amount of gain [boost], or gain reduction [cut] applied), center frequency 
(frequency), and range of affected frequencies (Q) around the center frequency.

Up to five parametric filters can be placed in the filter box at one time. Each can be set 
to a different frequency creating a five band parametric equalizer. The control boosts or 
cuts the center frequency. By changing the Q value, the range of affected frequencies is 
widened or narrowed around the center frequency. In general, a higher Q value results in a 
narrower affected bandwidth. 

To demonstrate how Q affects the filter, see the following filter block (see figure 29) 
containing five parametric filters centered at different frequencies but with the same Q 
of 1.0. The filter in focus (c) has a center frequency of 1000 Hz boosting that frequency 
+12 dB over a Q of 1.0. Note the markers on either side of the peak frequency are at 
300 Hz on the left and 3000 Hz on the right, a bandwidth of about 2700 Hz.

Figure 29.	 Parametric Filter Dialog Box, 1000 Hz

The dialog box (see figure 29) shows the frequency curve for the single active filter. To add 
its effect to the overall frequency response, remove the bypass on the other filters.
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By increasing the Q to 10.000, the center frequency remains the same. The markers show 
the bandwidth of the filter narrowed to between 900 Hz and 1200 Hz, or about 300 Hz 
(see figure 30). Parametric filters can be used to notch out a very narrow, or very wide 
range of frequencies using the Q setting.

Figure 30.	 Parametric Filter at 1000 Hz, Q: 10.000

The dialog window above shows the frequency curve for a single active filter. To add its 
effect to the overall frequency response, remove the bypass on the other filters. 
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The overall frequency response is now shown as a solid red line with the filter in focus 
(located in row 3 in figure 31) shown in the color of its table row.

Figure 31.	 All Parametric Filters Active

The parametric filter allows frequency selection accurate to 0.1 Hz and either 6 or 12 dB 
of slope. The 3 dB down point remains constant regardless of the slope setting. Only the 
steepness of the frequency attentuation curve changes. 
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Feedback Suppressor (FBS)
The Feedback Suppressor is used in live situations when there is an indication of 
feedback during live operation. Dynamic filters automatically detect feedback on a 
live microphone channel, and engage a set of up to 5 fixed and 15 dynamic filters to 
counteract frequency peaks at the detected feedback frequency. Up to 15 separate filters 
can be employed at any time. The 15 filters act in a FIFO (first in, first out) rotation. If all 15 
filters are employed when an additional feedback frequency is detected, it overwrites the 
first detected feedback frequency and so on. 

To avoid a new feedback frequency overwriting a previously detected one, up to five of the 
dynamic feedback frequencies can be placed into fixed filters. Once written into the fixed 
filters, the feedback frequency can only be overwritten by the user manually writing a new 
frequency to the filter. 

The FBS dialog box has three tabs; Settings, Dynamic Filters and Fixed Filters. 
Global settings and view options are controlled from the Settings tab. Dynamic to 
fixed filter allocations are handled from the Dynamic filters tab. Filter parameters can be 
modified from the Fixed Filters tab. 

The FBS Dialog box provides the following global buttons: 

•	 Clear All — Clears all dynamic filter settings.

•	 Lock — Locks the dynamic filters to the current settings, preventing automatic 
updates. This temporary mode is useful while testing the system, or during the time 
when dynamic filters are being converted to fixed filters. When the FBS display 
window is closed, lock mode is automatically disengaged.

•	 Bypass FBS — Turns off feedback detection when engaged (button is red). Only the 
dynamic filters are bypassed. Fixed filters remain active.

•	 Set Defaults — Click once to return the FBS to default settings.

Figure 32.	 Feedback Suppressor
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FBS Settings

The Settings tab enables selection of the feedback suppressor parameters. 

•	 For Composite View show: — The graph view is set by one of three buttons: 

•	 Only Dynamic FBS Filters

•	 Only Fixed FBS Filters

•	 Dynamic & Fixed FBS Filters (default)

•	 Mode: Q — Adjusts the notch filter Q used by dynamic filters. Similar to the 
parametric filter Q, it changes the bandwidth of the filter. The default setting can be 
modified in Tools>Options. The range is from 5 to 65. Larger values provide less 
change to the audio frequency response while lower values can provide greater 
feedback suppression but with more impact to the tonal response of the source 
audio.  
Suggested values for specific applications are:

Q Value Application

7 Voice with considerable feedback potential

30 Voice with less feedback potential 

65 Music with minimal feedback potential

•	 Attack Time — Sets the time at which dynamic filters are generated after feedback 
detection. A longer attack time (greater than 200 ms) reduces the chance that music 
or audio content will trigger the dynamic filters to respond. A shorter attack time (less 
than 2 ms) reduces the time between when feedback is detected and suppressed.

•	 Hold Time — Expressed in hours:minutes:seconds up to 9 hours. Hold time sets 
the time a dynamic filter setting persists before the filter is cleared. When hold time is 
disabled, dynamic filters persist indefinitely unless cleared manually or the device is 
power cycled.  
Hold time reverts to 00:00:00 when disabled (Enable unchecked).

Figure 33.	 FBS Settings Tab
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FBS Dynamic Filters

This tab contains the fifteen dynamic filters, with a scroll bar to display filters hidden due to 
dialog box size. 

Dynamic filters are notch filters that are cut only, providing attenuation up to 30 dB at the 
specified Q. The default Q is set in the Tools>Options menu, but can be changed on 
the settings tab prior to engaging the FBS dynamic filters. Changing the Q setting after 
dynamic filters have been generated clears all dynamic filters.

Figure 34.	 FBS Dynamic Filters Tab

Frequency and cut values are read only. Dynamic filters are in auto-detect mode when the 
FBS block is active (when Bypass FBS is off). If testing reaches a point where no further 
changes are desired, the lock button can be engaged. The lock mode of operation is 
temporary, and is intended to be used during setup of the FBS. When the FBS dialog box 
is closed, lock mode is automatically disengaged.

If there are specific dynamic filters the user wants to assure are not overwritten, press the 
Move to Fixed button to write the designated filter settings to the first available filter in the 
Fixed Filter tab.

NOTE:	 When a dynamic filter setting is moved to the fixed filter, it automatically 
clears that frequency from the dynamic filter. 

The Clear button removes a detected frequency from the corresponding dynamic filter. A 
cleared filter reverts to auto-detect mode unless Lock mode is engaged.
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FBS Fixed Filters

Fixed filters are notch filters with an adjustable center frequency and Q, and up to 30 dB 
of cut. The fixed filters are typically set by converting dynamic filters to fixed, however 
adjustments to filter parameters can be made manually from the Fixed Filters tab.

Fixed Filters are inactive and the filter type is set to Unused by default. 

Figure 35.	 FBS Fixed Filters Tab

No filter parameters are displayed when the filter type is set to Unused. As a filter is 
moved to the fixed filter tab from a dynamic filter, the filter becomes active and displays 
Notch as the filter type. The parameters copied from the dynamic filter are displayed in 
the same line. Once a fixed filter is active, settings can be modified or adjusted if needed. 
Fixed filters can also be individually bypassed by clicking the Bypass button.

FBS Settings Ranges and Fixed Filter Defaults

FBS Parameter Settings Range Default Setting

Frequency 20 Hz to 20 kHz N/A

Q 5.000 to 65.000 30.000

Attack Time 0.0 ms to 1000.0 ms 10.0 ms

Filter Hold Time 0 seconds to 9 hours 00:00:00; Disabled

Fixed Filter Parameter Settings Range Default Setting

Frequency 20 Hz to 20 kHz 1000.0 Hz

Q 1.000 to 65.000 30.000

Cut Up to 30 dB cut 0.0 dB
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Dynamics (DYN)
A dynamics processor alters the dynamic 
range, the difference between the loudest 
to the quietest portions, of an audio signal. 
Each input channel provides two dynamics 
processor blocks that, when inserted, provide 
one of four types; AGC, Compressor, Limiter, 
or a Noise Gate processor. 

To insert a processor into an empty block, 
select Insert from the processor menu. 
The menu appears when the block is 
double‑clicked, or is accessed from a context 
menu that appears when the block is right-clicked. 

Once the processor has been inserted, individual processor parameters can be changed 
in the dialog box, accessed by double‑clicking the processor block. For comparison, the 
block can be bypassed by clicking a Bypass button. 

All parameters are displayed in a text box with a resolution of 0.1 (dB or ms). Parameters 
are set by direct entry in the text box to replace existing text, then pressing <Enter>, 
<Tab>, or clicking to another area. Threshold, gain/attenuation, target, and ratio 
parameters have adjustment points on the graph display. Use the mouse to click + 
drag the graph point to the desired destination or value. All time values have a horizontal 
slider allowing adjustment in 1 ms increments by either a click + drag of the slider 
handle, or focusing on the slider, then using <Left> or <Right> arrow keys (<Page Up> 
and <Page Down> keys adjust in increments of 10 ms). 

The table below lists factory default settings for each dynamics processor type and 
parameter. 

Parameter AGC Compressor Limiter Gate

Threshold -40.0 dB -30.0 dB -10.0 dB -65.0 dB

Max Gain 12.0 dB

Target -10.0 dB

Window 12.0 dB

Attack Time 500.0 ms 5.0 ms 2.0 ms 1.0 ms

Release Time 1500.0 ms 100.0 ms 50.0 ms 1000.0 ms

Ratio 2.0 :1 20.0 :1

Hold Time 0.0 ms 100.0 ms 50.0 ms 300.0 ms

Max. Attenuation 25.0 dB

Soft Knee Off Off 

Details of the individual dynamics blocks follow. 
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Automatic Gain Control (AGC)

AGC adjusts the gain level of a signal based upon the input strength to achieve a more 
consistent volume. Below the set threshold, the signal is not affected. Above the threshold, 
weaker signals are boosted up to the maximum gain setting to reach a user‑defined target 
level. As the signal approaches the target level it receives less gain or no gain at all. Once the 
signal reaches the target level all gain is removed.  
Click in each field to change the values.

Threshold — The input level where maximum gain 
will be applied (after the attack time is exceeded). On 
the graph at right, follow the red input level from the 
lower left to -40 dB where the first red circle is. Signal 
levels less than -40 dB remain at their original levels. 
All signal levels at or exceeding -40 dB will have up 
to 12 dB of gain applied (see Maximum Gain, below). 

The threshold level can be adjusted from -80.0 to 
0.0 dB in 0.1 dB increments.  
Default is -40.0 dB. 

Maximum Gain — The highest amplification applied 
to a signal exceeding the threshold and up to the 
lower limit of the window (see Window, below). 

Maximum Gain can be set from 0.0 dB to +60 dB in 
0.1 dB increments. 
Default is 12.0 dB.

Target — The desired average signal level of the 
output when AGC is applied. AGC can vary the gain 
according to the input signal level, specified target 
level and maximum gain. As the signal approaches 
the target level of –10 dB, gain is reduced until at 
–10 dB, gain is no longer applied. 

The target level can be adjusted from -40 dB to 
0.0 dB in 0.1 dB increments. 
Default is –10.0 dB.

Window — Indicated by the two yellow lines, is a specified range above and below the target 
level. Below the lower line maximum gain is always applied to the signal. When the signal 
reaches the window, gain control begins scaling in a linear fashion to achieve smoother results 
as the signal reaches the target level. 

The window range can be set in 0.1 dB increments from 0.0 dB to 20.0 dB. 
Default is 12.0 dB.

Attack Time — Adjusts the time delay for AGC to engage after the input signal level reaches 
or exceeds the threshold level. 

Attack time can be adjusted from 0.0 to 3000.0 ms in 0.1 ms increments. 
Default is 500.0 ms.

Hold Time — Adjusts how long AGC continues after the input signal drops below the 
threshold and before release time begins. 

Hold time can be adjusted from 0.0 to 3000.0 ms in 0.1 ms increments. 
Default is 0.0 ms.

Release Time — Adjusts the time it takes to return the signal to normal (unprocessed) levels 
after the signal no longer exceeds the threshold level setting. Release time begins only after 
hold time is reached. 

Release time can be adjusted from 10.0 to 10000.0 ms in 0.1 ms increments. 
Default is 1500.0 ms. 
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Compressor

The compressor regulates signal level by reducing (compressing) the dynamic range of the 
input signal above a specified threshold. The input level to output level ratio determines 
the reduction in the dynamic range beyond the threshold setting. For example, with a ratio 
setting of 2:1, for every 2 dB of input above the threshold, the compressor outputs 1 dB. 

Compression is commonly used to contain mic levels within an acceptable range for 
maximum vocal clarity. A compressor can also make softer sounds louder in one of two 
ways. The dynamic range can be reduced by compressing the signal above the threshold 
while raising the post‑compressor gain/trim (referred to as "make‑up gain"). Alternately, 
the input signal can be increased while the compression ratio above the threshold is 
increased correspondingly to prevent clipping. Both techniques have the effect of making 
louder portions of a signal softer while at the same time increasing softer signals to raise 
them further above the noise floor. 

Compression can also be used to protect a system or a signal chain from overload similar 
to a limiter. Click in each field to change the value.

Threshold — The input signal level above 
which compression begins (subject to attack 
time) and below which compression stops 
(subject to hold and release time). 

The threshold level can be adjusted from 
-80.0 to 0.0 dB in 0.1 dB increments.  
Default is -30.0 dB. 

Ratio — The input signal level reduction 
when compression is engaged. 

Ratio can be adjusted from 1.0 to 100.0 in 
0.1 increments.  
Default is 2.0:1.

Attack Time — Adjusts the time delay for 
compression to engage after the input signal 
level reaches or exceeds the threshold level. 

Attack time can be adjusted from 0.0 to 
200.0 ms in 0.1 ms increments. 
Default is 5.0 ms.

Hold Time — Adjusts how long compression 
continues after the input signal drops below 
the threshold and before release time begins. 

Hold time can be adjusted from 0.0 to 
500.0 ms in 0.1 ms increments. 
Default is 100.0 ms.

Release Time — Adjusts the time it takes to return the signal to normal (unprocessed) 
levels after the signal no longer exceeds the threshold level setting. Release time begins 
only after hold time is reached. 

Release time can be adjusted from 10 to 1000.0 ms in 0.1 ms increments. 
Default is 100.0 ms. 

Soft Knee — Select the Soft Knee checkbox to smooth and soften the transition from 
uncompressed to compressed output levels. There are no adjustments.
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Limiter

The limiter restricts the input signal level by compressing its dynamic range above a 
specified threshold. The limiter is most commonly used to prevent clipping, protecting a 
system against component or speaker damage. While the limiter is closely related to the 
compressor, it applies a much higher compression ratio of ∞:1 above the threshold. The 
ratio is fixed and cannot be changed. Click in each field to change the value.

Threshold — The input signal level above 
which limiting begins (subject to attack time) 
and below which compression stops (subject 
to hold and release time). 

Threshold level can be adjusted from – 80.0 
to 0.0 dB in 0.1 dB increments.  
Default is –10.0 dB. 

Attack Time — Adjusts the time delay for 
limiting to engage after the input signal level 
reaches or exceeds the threshold level. 

Attack time can be adjusted from 0.0 to 
200.0 ms in 0.1 ms increments. 
Default is 2.0 ms.

Hold Time — Adjusts how long limiting 
continues after the input signal drops below 
the threshold and before release time begins. 

Hold time can be adjusted from 0.0 to 
500.0 ms in 0.1 ms increments. 
Default is 50.0 ms.

Release Time — Adjusts the time it takes 
to return the signal to normal (unprocessed) 
levels after the signal no longer exceeds the 
threshold level setting. Release time begins 
only after hold time is reached. 

Release time can be adjusted from 10 to 1000.0 ms in 0.1 ms increments. 
Default is 50.0 ms. 

Soft Knee — Select the Soft Knee checkbox to smooth and soften the transition from 
uncompressed to compressed output levels. There are no adjustments.
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Noise Gate

The noise gate allows an input signal to pass only when it exceeds a specified threshold 
level. Above the threshold level, the signal passes unprocessed. Below the threshold the 
signal is attenuated at the rate set by the ratio adjustment. The typical setting of the noise 
gate threshold is just above any noise level in the environment or source equipment. That 
allows signals that are above the noise to pass, and attenuates the noise when there is no 
signal, eliminating background noise. 

Threshold — The input signal level below 
which attenuation (gating) begins (subject to 
attack time) and above which gating stops 
(subject to hold and release time). 

The threshold level can be adjusted from 
-80.0 to 0.0 dB in 0.1 dB increments.  
Default is -65.0 dB.

Max Attenuation — The maximum 
attenuation of the signal when it drops below 
the threshold. 

Maximum attenuation can be adjusted from 
0.0 to 80.0 dB in 0.1 dB increments.  
Default is 25.0 dB.

Ratio — The input signal level reduction 
when gating is engaged. 

The ratio can be adjusted from 1.0 to 100.0 
in 0.1 increments.  
Default is 20.0:1.

Attack Time — Adjusts the time delay for 
gating to engage after the input signal level 
drops below the threshold level. 

Attack time can be adjusted from 0.0 to 
200.0 ms in 0.1 ms increments. 
Default is 1.0 ms.

Hold Time — Adjusts how long gating continues once the input signal rises above the 
threshold. If the signal is still above the threshold when hold time ends, release time 
begins. 

Hold time can be adjusted from 0.0 to 500.0 ms in 0.1 ms increments. 
Default is 300.0 ms.

Release Time — Adjusts the time it takes to return the signal to normal (unprocessed) 
levels once the signal has increased above the threshold level setting. Release time begins 
only after hold time is reached. 

Release time can be adjusted from 10.0 to 1000.0 ms in 0.1 ms increments. 
Default is 1000.0 ms. 
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Delay (DLY)
The delay processor, when inserted, provides a means to delay the audio signal. Audio 
delay syncs audio to video or can time-align speakers placed at different distances from 
the listener. The DMP 64 can set delay by either of two criteria: time or distance (feet or 
meters). 

The default units setting is time with a range of 0.0 ms to 200.0 ms adjustable in 0.1 ms 
steps. Default is 100.0 ms. 

Settings are controlled with a vertical slider and indicated with a value readout field. The 
value can be changed by clicking within the readout field, changing the number, then 
either pressing <Enter>, <Tab>, or clicking away from the field.  

Figure 36.	 Delay Dialog

Slider adjustments made in feet or meters correspond incrementally to the distance 
required to make 1 ms or 5 ms adjustments (detailed in the table below). If more precision 
is required, enter time in 0.1 ms increments directly into the readout field.

Method Time Feet Meters

Click + drag 1 ms ~1.1 feet ~0.3 m 

Focus + arrow 1 ms ~1.1 feet ~0.3 m 

Focus + Page Up/Down 5 ms ~5.6 feet ~1.7 m

When distance (feet or meters) is chosen, the conditions (temperature) field becomes 
available and can be set either by degrees Fahrenheit or Celsius. When entering a 
distance, time delay compensation is automatically modified based on differences in the 
speed of sound due to air temperature. 

Default is 70 degrees Fahrenheit.

NOTE:	 When using distance (feet or meters), set a temperature value first, then set 
the distance.
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Ducking (DUCK)
Ducking provideds a means to duck, or lower, the level of one or more 
input signals when a specified source must take precedence. The 
ducking processor block, when inserted, provides a means to duck one 
or more mics and program material (ducking targets) when the processor detects a signal 
from the ducking source. Ducking lasts for the duration of the intertrupting signal (ducking 
source) determined by the threshold setting (plus hold and release time) and restores the 
original levels of the ducked inputs once the other signal has ceased. 

Ducking can be useful when:

•	 Program material needs to be attenuated in order to more clearly hear a narrator 
voice. 

•	 One microphone, such as one used by a master of ceremonies, needs to have priority 
over other mics, program material, or both. 

•	 A paging mic needs to attenuate all other signals.

All ducking processor blocks are controlled by a common dialog box that opens when any 
of the ducking blocks are selected (see figure 37). All empty ducking processsor blocks 
have no ducking source or target settings by default.

When the first ducking processor is inserted, that input is automatically set to Enable 
Mic/Line Source. All inactive ducking processor blocks have Enable Mic/Line 
Source unchecked by default. 

Figure 37.	 Ducker Configuration Dialog

Any of the six inputs can be ducking sources. Any or all of the remaining inputs and virtual 
sends can be targets.
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Ducking Configuration 
Ducking is configured in a dialog box that opens when an active ducking processor block is 
double-clicked (see figure 37 on the previous page). 

a Current source indicator
Shows the input selected as the ducking 
source. Ducker settings affect the input 
channel shown here. When a ducker 
dialog is opened for a channel, the current 
source defaults to that channel. The 
current source can also be selected by the 
priority readout/source selector (see below).

b Enable mic/line source checkbox 
When checked, ducking is enabled for the 
current source and the ducker processor 
block is lit. When unchecked, ducking is 
disabled for the current source. The ducker 
processor block is unlit. 

c Duck Targets: 
Shows all potential input targets. Only inputs 
that are checked are ducked. The current 
source is not available as a target (a source 
cannot duck itself). If the current source 
is designated as a target of another input 
channel, that input channel is not available (a 
target cannot be the source).

d Settings: 
Used to configure the parameter settings for the ducker source. When a ducker block is 
copied, these settings are transferred.

Threshold — Sets the input signal level, in dB, the ducking source must exceed before 
ducking begins. If ducking does not occur quickly enough to avoid loss of speech or program 
material from the ducking source, decrease this setting. If ducking occurs too soon, allowing 
background noise to trigger ducking, increase the setting. 

The range is -60 to 0 dB in 1 dB increments.  
Default is -30 dB.

Attack Time — Adjusts the time to duck the targets once the threshold is exceeded.  
The range is 0 to 3000 milliseconds in 1 millisecond increments. Default is 1 millisecond.

Hold Time — Determines the time, in milliseconds, after a ducking source signal drops below 
the threshold before ducking ceases. 

The range is 0 to 10000 milliseconds in 1 millisecond increments.  
Default is 1000 milliseconds (1 second).

Release — Determines how long, in milliseconds, after the ducking source level is below the 
threshold and the hold time is met, the ducking targets take to restore signal levels.

The range is 10 to 10000 milliseconds in 1 millisecond increments.  
Default is 1000 milliseconds (1 second).

a
b

e

f

g

c

d
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Ducking Priority 

Multiple levels of ducking can be required enabling an input source to take precedence 
over all but one other input. In this example, inputs 2 through 6 are set to duck when 
Input #1 has a signal above the ducking threshold. Input #2 is set to duck inputs 5 and 6. 
Since Input #1 has previously been set to duck Input #2, Input #1 is disabled to prevent 
contradictory priorities.

Figure 38.	 Ducker Configuration, Input Priority

The priority tree outlined on the right side of figure 38 shows the inputs arranged by 
their priority status. Input #1 has all other ducked inputs under it, therefore if a signal is 
detected, it will trigger Inputs 2 through 6 to duck. If Input #2 detects a signal and there is 
no signal on Input #1, Input #2 will trigger inputs 5 and 6 to duck. However, if the Input #1 
signal exceeds the threshold, it will then duck all inputs including Input #2. 

NOTE:	 Ducking attenuation is not additive. When an input target is ducked, 
regardless of how far down the priority list it is, the maximum attenuation is what is 
set in the “by (dB):” column near the center of the dialog box.

e Priority 
Displays the hierarchy of ducking source to duck targets (see Ducking Priority below). 
Priority levels are displayed in tree fashion. Click an input channel to select that channel as 
the current source. The current source indicator (a) reflects the selected input channel.

f By (dB): (Target gain reduction amount)
Individual attenuation settings for each duck target in dB. If additional attenuation of a 
target is required, increase this value. 
The attenuation range is 80.0 to 0.0 dB in 0.1 dB increments. 
Default is 20.0 dB. 

g Mix Status (for virtual returns): 
Indicates whether the source is being routed to the virtual sends. This is a readout value 
only, shown for convenience during ducking configuration. 
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To set an additional ducking source:

1.	 Insert a ducking processor on the additional ducking source.  
In this example, input #2 is the second ducking source, with input #1, as shown 
above, as the first source. 

NOTE:	 Since it was previously selected as a 
ducking target, Input #1 is not available as a 
target of input #2.

2.	 Open the ducking dialog window for the input and 
select the desired duck targets. In this example 
inputs #5 and #6 are the ducking targets of input 
#2.

Any signal on input #2 that exceeds the ducking 
threshold now ducks inputs #5 and #6. The 
ducking targets can be changed at any time by 
double‑clicking the input #2 ducking processor 
block. 

If a signal on input #1 exceeds the ducking 
threshold, inputs #2 to #6 are still ducked regardless 
of whether the signal on input #2 exceeds its ducking threshold.

NOTE: 	 No input is ducked more than the level set in the by (dB): box.

Ducker Tutorials
The examples below are based on different input configurations. Insert a ducker from a 
ducker processor block using one of the following methods: 
Double-click the block, 
then click Ducker

Right-click the box to open context
menu, then click Insert Ducker

-or-

Once inserted, double-click on the ducker block to open the ducker configuration dialog 
box. The Enable Mic/Line Source box is checked. 

Ducking and Priority Ducking

The first inserted channel ducks all selected targets. 

To set a ducking source:

1.	 Insert a ducking processor to input #1. 

2.	 Open the ducker configuration box and select the 
desired duck targets. In this example inputs #2 to 
#6 are the ducking targets.

A signal on input #1 that exceeds the ducking 
threshold now ducks inputs #2 to #6.  

The ducking processor also provides a means to have 
an additional input duck other targets using the priority 
feature. The second input ducks its selected duck 
targets, and can also be ducked by the first ducking 
source. 
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Pre-mixer Gain (GAIN)
The post-input processing gain control (also called the pre‑mixer 
gain) provides gain or attenuation post-processing gain block. It 
includes a mono long-throw fader with a – 100.0 to +12.0 dB gain 
range, and a current level setting readout below the fader. Fader 
adjustments are in 1 dB increments, while adjustments can be 
entered manually to 0.1 dB resolution.  
Default is unmuted at unity (0.0 dB) gain. 

Selecting the fader handle with the mouse or clicking within the fader 
area brings focus to the fader. The input signal level can be adjusted 
using any of the following methods:

•	 Select and hold the fader handle, then drag it to desired level in 
1.0 dB steps.

•	 Select or tab to the fader handle, then use the up/down arrow to 
set the desired level in 1 dB steps.  
<Page Up> and <Page Down> increases and decreases level in 5 dB steps.

Click in or tab to the level readout field. Type a new value, then press <Enter> or <Tab> to 
another area. .
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Line Output Channels
There are four mono line output channels. Controls and processing blocks, identical for 
each output channel, are described in the following sections. 

Loudness (LOUD)
The loudness processor, when inserted, applies a filter compensation curve to the signal 
in an inverse relationship to the output volume control setting. The higher the gain setting, 
the less loudness compensation is applied. Generally, as volume is lowered, perception 
of certain frequencies is progressively diminished, returning to a more flat response as 
volume is increased. Loudness boosts those diminished frequencies to the highest degree 
at low volume levels, decreasing the boost as volume increases.

The bypass button is red when engaged (loudness control defeated), and gray when 
disengaged (loudness control active). 

When bypassed, the graph displays the current filter curve as a dotted line. When bypass 
is disengaged, the current filter curve is displayed as a solid line.

Figure 39.	 Loudness Dialog Window

The Loudness dialog window contains the following elements:

•	 Graph — Displays the compensation curve applied to the signal. These curves are 
read-only, and are not adjustable from the graph.

•	 Loudness Compensation slider — From a center zero-point, the user can slide to 
the left for less loudness compensation (filter curve is reduced), or to the right for more 
(filter curve is increased). The slider position is translated into a dB value, displayed in 
the compensation readout box contained in the Advanced Calibration section. The 
slider has a 48 dB (±24 dB) range. 

•	 Advanced Calibration — The advanced calibration box provides a value that 
corresponds to the position of the compensation adjustment slider. The SPL box 
displays the summed value of the slider and the preceding trim control.

 

DMP 64 • Software Control 56



Calibrating Loudness

The user can fine-tune the amount of loudness compensation using the compensation 
adjustment slider and adjusting "by ear," or by measuring SPL levels in a particular room, 
then using the slider to adjust the loudness filter relative to the SPL of the room and 
system gain structure.

Before calibrating loudness, set up the system gain structure (see Optimizing Audio 
Levels on page 88). A pre-recorded track of pink noise or pink noise from a signal 
generator is preferable for this purpose. Program material can also be used (using familiar 
material is recommended). 

If using a signal generator, set it to output -10 dBu. Tthen set the input gain of the 
DSP Configurator so the input meter reads -20 dBFS. If using a recorded source, the 
pink noise should be recorded at -20 dBFS and the player output level setting control set 
to maximum, or 0 dB of attenuation. For program material, set the input level to meter at 
approximately -15 dBFS, with peaks safely below 0 dBFS. 

Unmute the mix-point from the pink noise source to the output connected to the room 
amplifier being calibrated. With the basic gain structure previously set up, loudness can be 
calibrated using an SPL meter or by ear. Loudness can also be set using an SPL meter, 
then fine-tuned by ear.

To calibrate loudness, use a sound pressure level meter set to “C” weighting: 

1.	 Set the Loudness processor to Bypass (Bypass button red).

2.	 Place the meter in an average (but somewhat prominent) listening location. 

3.	 Generate pink noise, or start the program material playback.

4.	 Measure the SPL in the room. 

5.	 In the loudness dialog, adjust the slider until the value in the SPL readout box matches 
the reading on the SPL meter. 

NOTE:	 Theoretically, calibration can be performed with the output channel volume 
and post‑mixer gain level set to any comfortable listening level. But a relatively 
loud volume (well above the ambient noise in the room) that can be easily 
measured is preferred. 

Loudness is now calibrated. Disengage Bypass to hear the compensation.

Alternate method to calibrate loudness:

1.	 Set up the procedure using step 1 through 3 of the previous procedure.

2.	 Set the compensation adjustment slider to its default center position

3.	 Set the output channel volume fader to 0 dB (100% volume), 

4.	 Adjust the amplifier until the SPL meter reads 90 dB. 

Loudness is now calibrated. This method works if 90 dB is an acceptable volume limit for 
the room. 

Setting Loudness “By Ear”

When setting loudness by ear, it is essential the system gain structure be set up first. Sit in 
an average (but somewhat prominent) listening location. 

1.	 Set the loudness processor to Bypass.

2.	 Set the output volume fader in the DSP Configurator to a relatively quiet listening level. 
Filter compensation from the loudness processor is most prominent at low listening 
levels. Use familiar program material set to the levels described earlier.

 

DMP 64 • Software Control 57



3.	 Set the Calibrate slider to 0, the center point. Disengage the loudness Bypass. The 
result is a moderate enhancement to the program material, with more accentuated 
bass frequencies (below 500Hz), and more brightness in the high frequencies that 
carry harmonic content (above 7kHz). Engage and disengage the Bypass switch in 
order to “A/B” the difference between loudness off and on, respectively. 

4.	 To experiment with loudness compensation, move the loudness compensation slider 
to the left (less) or to the right (more). 

5.	 Adjustments made to the loudness compensation slider carry through to all listening 
levels. Set the output volume fader in the DSP Configurator to a relatively loud 
listening level. 

6.	 Engage and disengage the Bypass switch in order to compare the difference between 
loudness off and on. At a loud listening level, the difference should be minimal or 
barely perceivable.

Delay Block (DLY) 
The delay processor block, when inserted, provides 
a means to delay the audio signal to compensate for 
loudspeaker placement in situations where speakers 
delivering the same signal are much farther away than 
others. The delay processor block is identical to the delay processor available on the 
input and described in Delay (DLY) on page 48. Typically the near speakers would be 
delayed so that audio delivery time matches the speakers further away.

Filter Block (FILT) 
The filter processor block, when first inserted, provides one of four 
filter selections: High Pass, Low Pass, Bass & Treble filters and 
Parametric EQ. Up to nine filters can be added to each filter block. 
The output filter block is identical to the input filter processor block 
except that up to nine filters total can be selected Filter (FILT) on 
page 29.

NOTE:	 Selecting the Bass & Treble Filter inserts two separate filters.

Dynamics Block (DYN) 
A dynamics processor block, when inserted, 
provides one of four dynamics processors: 
AGC, Compressor, Limiter, and Noise Gate. 
The available processors are identical to the 
processors available on the input dynamics 
processor block and described in Dynamics 
(DYN) on page 43.
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Volume Control (VOL)  
Each output channel volume block provides a mono long‑throw 
fader with a range of 0 to 100 dB of attenuation, and a volume 
setting readout (in dB) below the fader. Volume level is adjustable 
with the slider or by entering the desired level directly into the 
volume setting readout in 0.1 dB increments. 

Clicking the fader handle or clicking within the fader area brings 
focus to the fader. The input signal level can be adjusted using any 
of the following methods:

•	 Click and hold the fader handle, then drag it to desired level in 
1.0 dB steps.

•	 Click or tab to the fader handle, then use the <up> and <down> 
arrow keys to change the desired level in 1 dB steps. The 
keyboard <Page Up> and <Page Down> keys increase or 
decrease the level in 5 dB steps.

•	 Click in or tab to the level readout field. Type a new value, then 
press <Enter> or <Tab> to another area.

Output polarity switching is also provided with a button that toggles polarity. 

The default setting is unmuted, at 0 dB attenuation. A peak meter displays the real‑time 
audio level from –  60 to 0 dBFS. 

The OK button accepts settings and closes the dialog with a click. The Cancel button 
ignores changes and closes the dialog.

The output volume control provides level control for each output. The output control is a 
trim control adjustable from – 100.0 to 0 dB. The default setting is unity gain (0.0 dB).

The Polarity button, accessible in the dialog box, allows the polarity of the wires 
connected to the audio connectors (+/tip and -/ring) to be flipped in order to easily correct 
for miswired connectors.

The Mute button, accessible in the dialog box, allows the post-meter audio output to be 
silenced. When the audio output is muted, the mute button lights red, and red indicators 
in the block turn on. If the output has been grouped with other inputs or outputs, the 
group number will be indicated on the right side of this button.
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Virtual Bus Returns
There are four mono virtual bus return inputs, fed by the virtual bus sends. Channel 
controls and processing blocks described in the sub-sections that follow are identical for 
each virtual bus return channel, A through D.

The virtual bus is used when additional processing of an input signal is required. It is also 
useful to apply identical filtering, dynamics processing, loudness compensation, or signal 
gain/attenuation to multiple inputs.

Filter (FILT)
Filter function and interface is identical to the mic/line input channel Filter block with the 
exception that only three filters are allowed (see Filter (FILT) on page 31, for additional 
information).

Dynamics (DYN)
There is one dynamics processor block available on each virtual path. Dynamics function 
and interface is identical to the mic/line input channel Dynamics block (see Dynamics 
(DYN) on page 45 for additional information).

Loudness (LOUD)
There is one loudness processor available on each virtual path. The loudness function and 
interface is identical to the output channel Loudness block (see Loudness (LOUD) on 
page 56).

Gain (GAIN)
Each virtual input channel gain block provides a mono long-throw fader with a –100.0 
to +12.0 dB gain range, and a level setting readout below the fader. Fader behavior 
is identical to the pre-mix-point gain block, described in the mic/line input section 
(see Pre-mixer gain (GAIN) on page 55). Fader adjustments are in 1 dB increments, 
while adjustments can be entered manually to 0.1 dB resolution.  
Default is unmuted at unity gain (0.0 dB). 
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Primary Mix Matrix
The DSP architecture contains a primary mix matrix that connects the mic/line inputs 
and virtual bus returns to the line outputs. The DSP Configurator user interface provides 
control of the primary mix matrix, used to set mix levels from the post processing inputs 
and post processing virtual returns to each line output bus. Each mic/line input and 
virtual bus return is connected to a mix‑point for each of the four line outputs. In general, 
mix levels are set relative to each other, achieving a desired blend of input signals at an 
optimal output level, close to, but not exceeding 0 dBFS at the line output volume block 
level meter (while accounting for processing that can occur in the line output signal chain). 

Shown below is a block diagram of the DMP 64 represented in the DSP Configurator, with 
a red box indicating the primary mix matrix. 

NOTE:	 Although the virtual bus send and return lines, A to D, are shown as end 
points in the block diagram below, they are connected A to A, B to B, C to C and 
D to D.

From the primary mix matrix, any or all of the six inputs can be routed to any or all of the 
four outputs. Any or all of the six inputs can also be routed to the secondary mix matrix.

Mic/Line Input 1

Mic/Line Input 2

Mic/Line Input 3

Mic/Line Input 4

Mic/Line Input 5

Mic/Line Input 6

A

B

C

D

1

2

3

4

5

6

A B C D

1

2

3

4
Outputs

Virtual Bus Send

Virtual Bus Return

FLTDLYLOUD DYN VOLTRIM

FLTDLYLOUD DYN VOLTRIM

FLTDLYLOUD DYN VOLTRIM

FLTDLYLOUD DYN VOLTRIM

GAIN GAINFLT FBS DYN DYN DLY DUCK

GAIN GAINFLT FBS DYN DYN DLY DUCK

GAIN GAINFLT FBS DYN DYN DLY DUCK

GAIN GAINFLT FBS DYN DYN DLY DUCK

GAIN GAINFLT FBS DYN DYN DLY DUCK

GAIN GAINFLT FBS DYN DYN DLY DUCK

Inputs

FLT DYN GAINLOUD

FLT DYN GAINLOUD

FLT DYN GAINLOUD

FLT DYN GAINLOUD

Primary Mix Matrix

Main Mix-Points

Virtual Return
Mix-Points

Figure 40.	 Primary Mix Matrix (outlined in red)
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Mix-point Behavior:

No mix information — A faint gray circle on the 
mix-point indicates it is muted (contains no mix 
information).

Mix information — A solid teal-colored circle 
indicates the mix‑point contains mix information (the 
mix-point is unmuted).

Mouse-over — The cursor changes to a hand 
when a mouse‑over occurs at a mix‑point, whether 
the mix-point contains mix information or not.

Single-click — A single-click brings focus to 
(selects) the mix-point, indicated by a dark green 
outline around circle.

Double-click — Opens the mix‑point dialog box. 
The focus circle turns light green in color to indicate 
the open dialog box. If the mix‑point is muted, the 
circle is gray. If unmuted, the circle is teal.

Multiple open dialog boxes — When multiple 
mix-point dialog boxes are open, the mix-point for 
the most recently opened dialog box receives the 
light green focus circle, while previously opened 
dialog boxes relinquish their focus. Focus can be 
returned by either clicking on a previously opened 
dialog box, or by double‑clicking on a mix-point.

 

DMP 64 • Software Control 62



Clicking a mix‑point brings focus to that mix‑point. A circle appears around the teal 
mix‑point which remains transparent. Double-clicking a mix‑point opens a configuration 
dialog box with the following components:

•	 Mono Fader — Sets the signal level from the selected input 
to the output bus. Gain range is -35 dB to +25 dB. Fader 
behavior is identical to the input channel gain block described 
in the mic/line input section with the exception that course 
adjustment (keyboard <Page Up> and <Page Down>) 
increases or decreases in 5 dB increments.

•	 Mute — Mutes and unmutes the signal to the output bus. The 
mix‑point ball is transparent when muted (Mute button red) and 
solid when unmuted.

•	 OK/Cancel — click OK to accept changes and close the box. 
Cancel ignores changes and closes the dialog box.

The title above the fader reflects the input and output channel 
names for the mix‑point. The example on the right is the Input #1 
to Output #1 mix‑point set to 0.0 dB. 

The input level text below the mute button indicates the input level 
setting for the input gain control of the selected input signal path, in this example 0 db.

Only when the mix‑point is unmuted does the circle become solid.
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Mix-point Examples
In order to better understand how mix-points work, the following diagrams provide 
examples of different mix setups. 
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Figure 41.	 Input 1 to Output 1

In the first example (see figure 41), input audio from Mic/Line Input 1 is processed and 
arrives at the output mix-point. Double-click on the mix-point to open the dialog box. The 
mix‑point opens muted (mute box is red). When the mute button is released, the mix‑point 
turns teal with a light green circle to indicate the open mix‑point dialog box is the focus, 
and the signal is routed to output 1.

The mix level can be adjusted using the slider or by direct input of a value between 
-35 and 25.0 dB into the dialog box below the slider.
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Figure 42.	 All Inputs to Output 1

In the next example (see figure 42), input audio from all six mic/line inputs are processed 
individually and arrive at the primary mix-points. When the individual mix‑point mute 
buttons are released, the primary mix-point junctions turn teal, and all six signals are 
routed to output 1. Since all six inputs are now on the output 1 signal line, open the 
individual mix-point dialog boxes to adjust signal levels for the desired balance. 

In this manner, any single input, or any number of inputs can be routed to any single 
output or any number of outputs. 
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Figure 43.	 Input 1 to All Outputs
In this example (see figure 43), input 1 has been routed to all four outputs by unmuting the 
mix‑point for mic/line input 1 on each output (1 to 4) bus. Again, the primary mix‑points 
are teal to indicate the active routing.
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Secondary Mix Matrix
The DSP architecture contains a secondary mix matrix that connects the mic/line inputs 
and virtual bus return signals to the virtual bus sends. The DSP Configurator user interface 
provides control of the secondary mix matrix, used to set levels from the post-processing 
input line and virtual bus return signals to the virtual bus sends. Each of the six mic/line 
and four virtual return inputs connect to a mix-point for virtual bus A through D. Each 
mix-point is muted and set to 0.0 dB (unity gain) by default. In general, mix levels are set 
relative to each other, achieving a desired blend of input signals at an optimal level close 
to, but not exceeding 0 dBFS at the output volume level meter. 

The secondary mix matrix contains a section (see figure 44) allowing virtual bus returns 
to be routed back to the secondary matrix to allow further processing using an additional 
virtual bus processing block. To prevent feedback loops, a virtual channel is prevented 
from being routed back to itself by eliminating the mix-point that would allow that to occur. 

In situations requiring extra processing, the virtual bus return output is routed back to the 
secondary mix matrix, virtual bus send, which then routes the signal back to a processing 
signal chain other than the one it was routed from.
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Figure 44.	 Secondary Mix Matrix
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In the example below (see figure 45), input 1 is sent to the virtual bus send by muting all 
four signals on the input 1 primary mix-points. The virtual bus now serves as additional 
signal processing for the input. The signal routes over virtual bus A and through the signal 
chain before being sent to the virtual bus return mix‑point and output 1.

This configuration is useful when more than one input requires identical processing. 
For example if all inputs were normalized but required a uniform gain to bring them up 
to adequate output levels, rather than changing each pre-mix gain control by a similar 
amount, all six inputs can be routed to virtual bus A. Then, using the virtual bus A return 
gain control, a single adjustment can apply the same gain to all six inputs before sending 
the signal to the desired output line.

In other cases, if multiple microphone inputs are being mixed with program material, only 
the program material might require loudness contouring. The microphones can be routed 
directly to the output while the program material input is routed to the virtual bus return 
where loudness contouring can be applied. The program material is then routed to the 
same output as the microphones. 
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Figure 45.	 Input 1 to Virtual Bus A
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Group Masters
There are 32 Group Masters that can each be configured to simultaneously control up 
to 16 group members. Group masters are configured in the DSP Configurator program 
and saved in the device. Working in emulate mode, group masters can be saved in a 
configuration file and pushed to the device upon connection. 

A group master can either be a gain control or a mute control. Only one control type 
can be selected as group members for control by a group master. For example, a group 
master can be configured to control post-matrix gain levels, but not post-matrix gains 
plus input gain block. A group member can, however, be controlled by multiple group 
masters. It is recommended this feature be used cautiously, as overlapping membership 
can quickly become unmanageable. 

Group master gain controls can send specific values, such as those sent by a fader 
control. Group master gain can also be set by increment/decrement. For information on 
using increment/decrement controls within the DSP Configurator software (see Tools on 
page 73). 

Group Members
Once a group has been created, the group members, the individual controls that 
comprise the group, update to indicate they are now part of a group. Group members 
can be controlled individually, allowing for relative levels between group members to be 
fine‑tuned. Group member levels can also be set by a preset recall.

Grouped Controls
Grouping is convenient when multiple controls require muting at the same time or when 
multiple signal levels need to be increased or decreased simultaneously. For example, in a 
system with several audio outputs dedicated to a single room, the operator may want all 
outputs to change at the same rate and at the same time. The output 1 through 4 volume 
controls can be grouped into a master that controls the volume throughout the room.

For further flexibility, individual volume controls in the group can be set for an output level 
based on its use. When the group fader is moved, all four output control faders move in 
tandem while retaining their levels relative to each other.

Grouped faders move together at relative levels to the top or bottom of their travel 
(see Figure 46). If one fader reaches the limit of its travel first, it retains that position 
while the other faders continue to travel. When the grouped faders travel in the reverse 
direction, the fader that was at its limit reverts to its position relative to the other faders. 

NOTE:	 If a block was previously muted when the group mute is activated, that block 
remains muted when the group mute is released.

TIP:	 When including a control in multiple groups, do so with care. Overlapping 
group membership can quickly become unmanageable. Use presets to set 
individual faders to known levels.
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Figure 46.	 Sample Fader Group Master and Associated Gain Controls

Mute controls within the blocks can also be grouped (see figure 47). 

Figure 47.	 Sample Mute Group Master and Muted Outputs
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Configuring a Group Master
Configure a group as follows:

1.	 Click Tools > Configure Groups to open the Configure Groups dialog box, 

or click View > Group Controls and then click the Add a Group menu selection.

2.	 In the Select Group drop-down box, click a group to select it (see figure 48). The 
list defaults to the first empty group. Select an empty group to begin a new group, or 
select an existing group to modify.

Figure 48.	 Configure Groups Add Group Dialog Box

NOTE:	 <empty> groups have no group members assigned. Numbered groups 
(such as <Group #1>) have controls assigned that can be overwritten if selected.

3.	 In the Select Control Type section, expand the tree for the type of control, Gain 
or Mute, then select the desired control type. When a selection is made in the Select 
Control Types section, the Available Group Members section populates with all 
possible members for the selected control type. 

NOTE:	 Potential group members in step 3 that are assigned to a different group 
are displayed in blue.

4.	 In the Available Group Members section, make appropriate selections by clicking 
the checkbox. When a + sign exists, click to expand the tree and select individual 
controls. Up to 16 group members can be added.

5.	 Click the Apply button to create or configure the group.

6.	 Repeat steps 2 through 5 to create or configure up to 32 groups.

7.	 Click the Close button to exit the configure groups dialog box.
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Deleting a Group Master
To delete a group:

1.	 Click Tools > Configure Groups to open the configure groups dialog box 

or click View > Group Controls and then click Add a Group.

2.	 In the Select Group drop-down box, click a numbered group (such as "Group #1") 
to select it.

3.	 Click the Delete Current Group button in the lower left area.

4.	 Click Yes in the Confirm Deletion dialog box.

Viewing and Using a Group Master
Click View > Group Controls to open the group controls dialog box (see figure 49). The 
group controls dialog contains two menu items:

•	 Add a Group allows you to add additional groups.

•	 Tools enable you to perform various functions from the group controls window.

In addition, once groups are created, a single mute button or a group fader plus the 
current setting readout and any soft limits that have been set are visible.

Figure 49.	 Group Controls Dialog Box

The group fader controls function as follows:

•	 Slide a group fader up and down to adjust all gain controls in the group.

•	 Click and drag a soft limit ( ) to set the ceiling and floor for the group.

NOTE:	 Soft limits cannot be dragged beyond the current setting of the group 
fader.

Add a Group
To launch the configure groups dialog from the group controls window, click 
Add a Group. When a new group is added and the Add New Group dialog is closed, the 
group controls window refreshes to display the added control.

NOTE:	 If a block is muted when the group mute is selected, that block remains 
muted when the group mute is released.
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Tools
The Tools menu contains three selections:

•	 Clear All Groups - clears all group members and group master parameters.

•	 Increment/Decrement Simulator - allows the user to test increment/decrement 
values, see below for more information.

•	 Group Details Report - generates a report, listing all group masters and 
membership.

Clear All Groups

Click Tools > Clear All Groups to delete all groups and reset all group memberships. 
Soft limits are also cleared.

Increment/Decrement Simulator

The Increment/Decrement Simulator provides a control for increment and decrement, with 
the ability to set increment and decrement values. This control is temporary, since the 
value is not remembered in the device. 

To use the Increment/Decrement Simulator:

1.	 Select Tools > Increment/Decrement Simulator.

2.	 Select the group to be controlled from the Select Group drop-down list. The 
following dialog box appears:

Figure 50. Increment/Decrement Simulator Dialog Box

NOTE:	 The Number of Group Members: readout indicates the number of 
controls affected.

3.	 Enter an increment value and a decrement value. The default value is 1. 

NOTE:	 The size of the increment can be changed by typing a value in the 
Increment Value or Decrement Value field. Values can be as large as the 
maximum range of the control or as fine as 0.1 dB. For groups controlling mute, 
1 is the only valid value.

4.	 Click the Increment and Decrement buttons as needed. The group master control 
increases or decreases by the set value to the top or bottom of its soft limit range.

NOTE:	 When set, soft limits cannot be exceeded.
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Group Details Report

Select Tools > Group Details Report to create a Microsoft Word file that details all 
created groups (see figure 51).

 GROUP DETAILS REPORT
Group #1
 Processor Type: Output Volume
 Current Mute status: Unmuted
 Current Group Members:
  Main Amp (Output#1) Left Channel
  Stage Mixer (Output#2) Right Channel
  House Video (Output#3) Left Channel
  Prgm Record (Output#4) Right Channel

Group #2
 Processor Type: Pre-mixer Trim
 Current Gain value: 2 dB
 Current Group Members:
  Mic #1 (Input#1)
  Mic #2 (Input#2)
  Mic #3 (Input#3)
  Mic #4 (Input#4)
  Mic #5 (Input#5)
  Mic #6 (Input#6)

Figure 51.	 Sample Group Details Report

Soft Limits
Each gain type control provides upper and lower soft limits that can limit the range of 
the group master control. Soft limits ( ), shown at left, prevent group controls from 
exceeding an upper limit or going below a lower limit. They are easily adjustable and 
provide the ability to set a ceiling and floor for the group. When a group master is created, 
the soft limits default to the hard limits (maximum and minimum) of that group of controls. 

Soft Limits can be defined using the mouse by dragging the soft limit icon. The 
resolution is 0.1 dB. For more precise setting use the keyboard as follows:

Click within the group master fader to bring focus, then use the following key 
combinations: 

To move the upper limit:

•	 <Shift + Up/Down Arrow> key moves in 0.1 dB increments.

•	 <Shift + Page Up/Page Down> key moves in 10 dB increments.

•	 <Shift + Home> moves limit to upper default. 

•	 <Shift + End> moves limit to the current fader position.

To move the lower limit:

•	 <Ctrl + Up/Down Arrow> key moves in 0.1 dB increments.

•	 <Ctrl + Page Up/Page Down> key moves in 10 dB increments.

•	 <Ctrl + End> moves limit to lower default.

•	 <Ctrl + Home> moves limit to the current fader position. 
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Digital I/O Ports
The DMP 64 provides six digital I/O ports that can trigger external events from DMP 64 
actions, or allow external events to trigger DMP 64 actions. The DSP Configurator 
software provides pre-configured scripts with a fixed set of common trigger and event 
combinations. When selected, the script is compiled and placed onto the File 
Management system of the device. For more advanced or custom scripts, contact an 
Extron Electronics Applications Engineer.

When no scripts are active, the digital I/O ports default to DI (digital input) and inactive 
(‘Logic Hi’ ≈ +5 VDC). The DI detects a Logic Hi as +5 VDC and Logic Low (active) as less 
than +1 VDC. 

A DO (digital output) sends a Logic Lo as less than +1 VDC and a Logic Hi as +5 VDC. 
For every script that involves a DO, two versions are available to provide either a Logic Hi 
or a Logic Lo response to any action. The alternate script is designated as Reverse DO.

To build a script and place it into the DMP 64 File Management system:

1.	 From the tools menu, click Configure Digital I/O>Build Digital I/O 
Configuration. 

2.	 This brings up a dialog that allows selection from a list of pre-configured scripts.

3.	 Select a script from the Select a Digital I/O Configuration section. The 
event description section describes the script and how the digital I/O ports act while 
the script is running. Highlight the desired script, then click OK. 

4.	 A dialog box appears, verifying the file has been successfully uploaded to the device. 

NOTE:	 When performing this procedure in Emulate mode, the connection 
dialog appears between step 3 and step 4. DSP Configurator connects and 
then disconnects during the procedure, returning to Emulate mode when the 
Digital I/O has been configured.
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Reinitialize Digital I/O
Should the script stop running for any reason, select Tools > Configure Digital I/O, 
then select Reinitialize Digital I/O. This option is only available in Live mode.

To remove a digital I/O script from the DMP 64:

Only one digital I/O configuration can be active at a time. If the I/O activity needs to be 
modified, remove the current configuration by:

1.	 From the Tools menu, click Configure Digital I/O, then select Remove Digital 
I/O Configuration from the Device and click OK.

2.	 If the DSP Configurator is connected to a device, the I/O configuration is removed. If it 
is not connected, a connection dialog box appears. 

3.	 Make certain the connection information is correct, then press OK. The I/O 
configuration script is removed and a confirmation dialog box will appear. 

Emulate Mode and Live Mode
The DSP Configurator program has two operational modes, Live and Emulate. In 
Live mode, the program has established a connection and is synced with the DMP 64. 
Changes affect the device in real-time and changes in the current state of the device are 
reflected in the DSP Configurator. In contrast, Emulate mode allows the user to work 
offline, creating or editing configurations that do not immediately affect DMP 64 operation.

The DSP Configurator program always starts in Emulate mode. All functions of the 
DSP Configurator program are available without connecting to the DMP 64. The user 
can build a configuration from the blank screen, or open an existing file that contains the 
last configuration displayed plus saved presets. All settings and adjustments are saved 
to a configuration file on the PC. When the saved file is opened in the DSP Configurator 
program, the program restores all settings as the current configuration (emulated if in 
Emulate mode or live if in Live mode).

Live mode can be entered at any time after program launch, either with a blank 
configuration, after creating a configuration, or after loading a previously saved 
configuration file. 

In Emulate mode, the current state is titled Current Emulation. In Live mode, the 
current state is titled, Current State. 

Synchronizing: Pull From or Push To the DMP 64
When switching to Live mode after making changes to the current configuration in 
Emulate mode, either:

•	 Pull data from the device and update the DSP Configurator program configuration. 
This option downloads device settings from the DMP 64 and synchronizes it with the 
DSP Configurator program overwriting the current DSP Configurator settings, or

•	 Push data from the DSP Configurator program to the device, overwriting settings in 
the DMP 64.

Live mode can also be used to tailor audio settings in real time while listening to the 
audio output.
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Selecting Live Mode and Pushing or Pulling Data
To switch from Emulate mode to Live mode:

1.	 Select the desired connection to the DMP 64 and make the proper connections. 

NOTE:	 Extron recommends connection with the Ethernet LAN port when using 
DSP Configurator.

2.	 Click the Mode Live button, (see figure 52, b). The Communication Type 
selection window appears.

or or

Extron USB device

2

3

4a

4b

4c

5a

5b

5c

3

6a

6b

3

Figure 52. Selecting Live Mode

3.	 Click one of the following tabs:

•	 TCP/IP for connection using the LAN port (preferred) — proceed to step 4, 

•	 RS-232 for connection using either of the rear panel RS-232 ports — proceed to 
step 5, or

•	 USB for connection using the front panel configuration port — proceed to step 6.

4.	 If TCP/IP is selected in step 3:

a.	 Observe the IP Address field in the IP connection window. The field displays the 
last IP address entered.

•	 If the IP address is correct, proceed to step 4b.

•	 If the IP address is not correct, either click in the IP Address field and enter 
the IP address or click the drop-down arrow to open a list and select from a 
recently used address. Proceed to step 4b.

NOTE:	 If the local system administrators have not changed the 
address, the factory‑specified default, 192.168.254.254, is the correct 
value for this field.

b.	 If the device is password protected, click in the Password field and enter the 
appropriate administrator password.

c.	 Click OK.

The Synchronize with Device dialog box (see figure 53 on page 79) opens.  
Proceed to step 7.
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5.	 If RS-232 is selected in step 3:

a.	 Click the com port drop-down list and select the PC comm port connected to 
the rear panel RS-232 port.

b.	 Check the baud rate displayed in the Com Port selection window. If the baud 
rate does not match the device’s rate, click the Baud Rate drop-down menu and 
select the desired baud rate. The default is 38400.

c.	 Click OK.

The Synchronize with Device dialog box (see figure 53 on page 79) appears.  
Proceed to step 7.

6.	 If USB is selected in step 3:

a.	 Click the USB Device drop-down menu and select DMP 64 (or Extron USB 
device, if DMP 64 is not available),

b.	 Click OK.

The Synchronize with Device dialog box (see figure 53) appears.  
Proceed to step 7.
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7.	 Click either the:

a.	 Pull radio button to configure the DSP Configurator program to match  
the device — proceed to step 9

-or-

b.	 Push radio button to configure the device to match the DSP Configurator 
program — proceed to step 8

9 9

8

8a

10

8c

8e

8f

8d

7a

7b

-or-

8b

8d

Figure 53. Selecting Live Mode, continued
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8.	 To push all of the DSP Configurator gain and processor block adjustments 
(configuration), and all presets to the DMP 64, proceed to step 9.

To tailor the push (push only the configuration, only the presets, or the configuration 
and selected presets), click the Advanced button and proceed to step 8a.

a.	 Select the Custom radio button.

b.	 Select the desired checkboxes: Push Configuration, Push Presets or both. If 
Push Configuration is the only box checked, click OK and proceed to step 9.

NOTE:	 Push Configuration includes all mix-point, gain, and processor 
block settings. It does not include partial presets.

c.	 If Push Presets was clicked in step 8b, click All to select all presets or 
Selected to choose specific presets.

•	 If Selected was clicked, click OK and proceed to step 8d.

•	 If All was clicked (equivalent to a standard push), click OK and proceed to 
step 9.

d.	 If Selected was clicked in step 8c, the Synchronize with Device dialog box (7b) 
reappears. Click OK. The presets dialog box appears.

e.	 Select the desired partial presets to push by clicking the appropriate checkbox.

f.	 Click OK. — Proceed to step 10.

9.	 Click OK. The DSP Configurator program is connected live to the device, the 
processors and presets are pushed or pulled as selected, and the selection of Live 
mode is complete.

10.	 If changes were made to the DSP parameters (including mix-point, gain or processor 
blocks) since the last file save, the DSP Configurator prompts to save the file. Click 
Yes or No.

If a password is required and not entered or if an incorrect password is entered, the 
program prompts for the password.

The configuration and presets are uploaded to the DMP 64.
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Presets
Presets recall a group of frequently used settings. Presets created by DSP Configurator 
can contain all elements (gain blocks, processor blocks, and mix-points) or a portion of 
the elements available within the program. In Emulate mode, up to 32 partial presets 
can be created, uploaded as a set, and stored to the device or a disk as a configuration 
file. In Live mode, presets can be created one at a time from the current state. 
They can then be saved to a chosen preset number in the device, with the option to 
name or rename, or save it to disk.

When recalled, a preset overwrites only elements contained in the preset. Presets are 
useful when settings for a particular room or only certain elements of a configuration need 
to be changed regularly.

Presets can be created in Live or Emulate modes. In Emulate mode, the presets are 
created, saved to a file, then pushed to the DMP 64 when connecting in Live mode. 

When a pull data synchronization is performed, preset data remains in the DMP 64, with 
only the list of preset names pulled from the device. Presets in this state are marked with 
an asterisk until that preset is recalled (which pulls the preset data from the device), or 
until a backup is performed (see Backup on page 26). Presets pulled from the device 
cannot be saved to disk until they have been recalled, at which time the preset data is 
pulled into the DSP Configurator. Presets with no asterisk can be saved to disk. 

Saved presets can be recalled via the DSP Configurator, or a control system sending an 
SIS preset recall command. Presets can also be saved and recalled via the embedded 
web page. Presets saved using the web page interface contain input gain, output volume, 
and the primary mix-point settings. 

Previewing and Recalling a Preset
A preset can be previewed in either Live or Emulate mode by selecting the preset from 
the preset drop-down list. 

The program indicates a view-only preset configuration by displaying each preset element 
with a translucent green mask over the block. 

Figure 54.	 Preset Preview

Behavior for previewing and applying presets is as follows:

•	 Live Mode. After selecting a preset, the DSP Configurator displays the preset 
elements that will be affected by a preset recall with a translucent mask over the 
element. It leaves all other DSP Configurator elements unaltered. Elements without a 
translucent mask represent elements in the current state that will be unaffected by a 
preset recall. Real-time changes to the current state are not reflected onscreen while 
previewing a preset, and the user cannot alter those elements. To apply the preset, 
click Recall. The preset reverts to Current State. 

•	 Emulate Mode. After selecting a preset from the list the DSP Configurator displays 
the elements that will be affected by a preset recall with a green translucent mask, 
leaving all other elements (which represent the current emulation) unaltered. Click 
Recall to apply the viewed preset to the current emulation. The preset number 
reverts to Current Emulation. 

 

DMP 64 • Software Control 81



Building a Preset
Only elements of the preset highlighted (given focus) are saved as a preset. <Ctrl + A> 
highlights all elements within the DSP Configurator.

To build a preset, highlight the desired DSP Configurator elements (gain and processor 
blocks, and mix-points) using standard keyboard and mouse actions as follows:

1.	 Click the desired block to select a single block, 

2.	 <Ctrl + click> to select multiple blocks that are not adjacent,

3.	 With the first block selected, hold <Shift>, then click the last block in either a vertical 
column or horizontal row to select multiple blocks, 

4.	 Click and drag a selection rectangle to select multiple adjacent blocks in either the 
vertical or horizontal direction,

5.	 Go to Tools>Presets>Mark All Items or press <Ctrl + A>. This marks all 
elements within the DSP Configurator.

6.	 To save the selections see Save Preset below.

Save Preset

A preset can be saved in either Emulate or Live mode.

Saving a preset in Emulate mode stores it in the currently open file. The DSP Configurator 
file must then be saved to disk using File menu>Save (recommended), or pushed to the 
device after a connection is established. This differs from Live mode where a created 
preset is saved in real‑time to the device and becomes part of the configuration file. 

To save a preset use the following instructions:

1.	 Highlight the desired preset blocks using the previous instructions.

2.	 Select Tools>Presets>Save Preset in the main structural menu.

3.	 Select a preset number. In the Preset Name field, unused presets are named 
unassigned. To create a new preset, select an unused preset number and type a 
preset name. If no name is entered, a default name will be assigned. To overwrite an 
existing preset, select a preset with a name other than unassigned.

Figure 55.	 Save Preset

4.	 Click OK to save the preset, or Cancel to stop the save preset operation.
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Managing Presets

Once a preset is created (whether or not the DSP Configurator file is saved), it appears in 
the preset list, available from the DSP Configurator user interface. 

In Live and Emulate mode, after a preset is selected from the list, action buttons 
become available next to the presets bar.

The user can either Recall (make the preset active), Cancel (return to the current 
emulation or state), or Delete the preset. 

In Live mode, selecting Recall applies the currently displayed preset elements (“marked” 
elements) from the stored preset, overwrites that portion of the current state, and then 
switches the drop-down list to read Current State. 

In Emulate mode, the Recall action button applies the currently displayed preset 
elements (“marked” elements) from the file, overwrite the information contained in the 
DSP Configurator as the current emulation, then switch the drop‑down list to read 
Current Emulation.

When a preset is previewed in either Live or Emulate mode, the Delete button is 
available. When pressed in live mode, the preset is deleted from the hardware, which 
is reflected in software (it is removed from the preset list). After disconnecting from the 
device and before exiting the program, the file must then be saved to retain this change. If 
pressed in emulate mode, the preset is deleted from the file in software, which must then 
be saved (before exiting) to retain this change. In either mode, the Cancel button defeats 
the preview action and returns the user to current state or current emulation, respectively.

Presets: Pull vs. Push or Create Live

When a preset is pulled from the device, the preset data remains in the device until the 
preset is recalled. The DSP Configurator pulls only the names of the presets. These 
presets cannot be saved to disk until they have been recalled. 

An asterisk next to the preset name indicates that only the preset name has been pulled 
from the device, and the preset data exists only in the device (it has not been recalled). 
Presets pushed to the device or created in Live mode have no asterisk. Presets with no 
asterisk can be saved to disk.   

 

DMP 64 • Software Control 83



Protected Configuration
A protected configuration is secured with PIN protection. The protected configuration 
can be recalled by any user, but can only be written or overwritten using the assigned 
4-digit PIN. Utilities for Save, Recall, and Change PIN, (separate from preset save), are 
accessed from the Tools menu as three sub-menus under a protected configuration 
menu item.

Protected configuration menu items are only available in live mode from the Tools > 
Protected Configuration menu. These functions can only be performed in Live 
mode:

•	 Save 

•	 Recall

•	 Change Password

Save Protected Configuration
The default PIN is 0000. The user can enter the default PIN or use the Change PIN (see 
below) dialog box to create a new one. 

Recall Protected Configuration
The dialog box prompts the user to continue. Click OK to continue or Cancel to cancel 
the operation.

Change PIN
The change PIN utility allows the user to change a current protected configuration PIN. 
The current PIN must be entered before changes are allowed.
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DSP Configurator Windows Menus
The DSP Configurator program is fully navigable using the computer keyboard. Some 
keyboard navigation behavior matches Windows standards, while other behaviors are 
specific to DSP Configurator.

Keyboard Navigation
When the program starts, the cursor focus defaults to the mic/line input gain block 
(figure 56, a). The input 1 gain block is highlighted green [   ]. The <Tab> key toggles to 
the various sections outlined in red in figure 56.

Within the sections, the <navigation arrows> can be used to move one block right, left, 
up, or down within these sections.

NOTE:	 The callout numbers for figure 56 are not the same as figure 17.

a

b

c d

e fg

Figure 56.	 DSP Configurator Program Window

Standard Windows Navigation

The keyboard keys navigate and function as follows:

•	 Tab key —

Sequentially jump among major segments of the DSP Configurator program. From the 
audio input chains (a), sequential jumps are in the following order:

b	 Main mix-points

c	 Virtual return signal path 
d	 Virtual return mix-points

e	 Output signal chain 

f	 Mode (toggles to Live, then Emulate) 

g	 Presets (<Down> arrow can select presets) 
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•	 Shift+Tab key combination — Reverses the direction of the <Tab> key function.

•	 Arrow ( , , , and ) Keys — Navigate up, down, left, and right within any of 
the areas outlined in figure 56.

•	 Enter Key — Performs the same action as a mouse double-click. For 
example, it can open the context menu from which a processor type can be selected, 
or open a dialog box when applicable. When an action button is highlighted, <Enter> 
executes the button action and toggles the button when applicable.

•	 Control key — The <Ctrl> key can be used in the following shortcuts.

•	 <Ctrl+X> — Cut the selected elements.

•	 <Ctrl+C> — Copy the selected elements.

•	 <Ctrl+V> — Paste the selected elements from a previous cut or copy.

•	 <Ctrl+A> — The first press of the <Ctrl+A> combination highlights all matrix block 
nodes. 

•	 Alt key — <Alt> is used with specific letter keys to open and navigate task bar 
menus. When the <Alt> key is pressed and released, the File menu opens. When 
the <Alt> key is pressed and held, the first letters in the menu titles (File, Edit, View, 
Tools, Window, or Help) become underlined. Press the underlined letter key to open 
that menu.

•	 Once a task bar menu opens, use the <Up> and <Down> arrow keys to move up 
and down in the menu or submenu, use the <Right> arrow key to open a submenu (if 
applicable), and use the <Esc> key to back out of an active menu or submenu.

DSP Configurator-unique Navigation

Highlighting and marking items, cutting or copying, saving a preset:

When an item within the program is selected, it is highlighted by a green boundary box. 
One or more highlighted items can be cut, copied, pasted, or saved as a preset. The cut, 
copy, and paste functions can be performed using the task bar menus (see the <Alt> key, 
above) or the shortcuts described on the previous page.

NOTE:	 When an item is cut, it is not removed from its original location until it has 
been pasted in its new location.

Highlight multiple elements for cut, copy, paste, or a preset as follows:

1.	 Use the <Arrow> ( , , , and ) keys to move to the first block to be highlighted. 

2.	 To highlight a block:

a.	 Press and hold the <Shift> key, then use the <Arrow> keys to navigate away 
from the selected block.

b.	 To highlight additional sequential blocks, continue to hold the <Shift> key, 
then use the <Arrow> keys to navigate away from the selected block. Additional 
blocks will be highlighted as long as <Shift> is pressed. When the last element 
is highlighted, move the highlight box one additional block, then release the 
<Shift> key.

3.	 To move away from the highlighted block or set of sequential blocks, or to highlight 
non-sequential blocks:

a.	 After highlighting blocks in step 2, press and hold <Ctrl>, then use the <Arrow> 
keys to navigate to the next desired element. As long as the <Ctrl> key is 
held down, the block moved away from will not be highlighted. If the block is 
highlighted, it will be unhighlighted.

b.	 Release the <Ctrl> key, but do not press any <Arrow> keys.
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4.	 To highlight another element or group of elements, repeat steps 2 and 3 as required.

5.	 To cut or copy, press the <Ctrl+X> or <Ctrl+C> key combination.

6.	 To save a preset, press <Alt +T>, <Right Arrow>, <Down Arrow>, then <Enter>, 
(see figure 57 below).

7.	 The Save a Preset dialog box appears.

a.	 <Tab> to highlight the Preset Number field and type a specific number.

b.	 <Tab> to highlight the Preset Name field and type a name.

NOTE:	 Unless entering a specific number and name, DSP Configurator 
enters the next sequential unused preset number.

c.	 <Tab> to highlight the OK button and press the <Enter> key.

Alt T Enter

Figure 57.	 Saving a Preset Using Keyboard Navigation
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Optimizing Audio Levels
The DMP 64 uses floating point DSP technology, processing data using a combination 
of 32- and 64-bit algorithms. The analog to digital converters (ADC) and digital to analog 
converters (DAC) sample at 48 kHz with 24-bit resolution. 

With floating point DSP it is extremely difficult to clip the audio signal within the DSP audio 
signal chain, after the ADC input and before the DAC output. That means the audio signal 
must not be clipped at the input ADC. Clipping gives audibly undesirable results and once 
the audio is clipped at the input there is no way to correct it further down the signal chain. 
If audio clipping occurs at the output DAC that is not a result of clipping at the input ADC, 
there are ways to address it within the DSP audio signal chain.

The meters in the DSP Configurator indicate clipping at a user-definable point, 
with the default setting at –1 dB. This means the meter indicates clipping when it 
reaches –1 dBFS, or 1 dB below actual clipping (0 dBFS). Setting the clipping meter 
below clipping provides a “safety net”, allowing the user to reduce input gain before 
clipping actually occurs. This safety net can be increased or decreased by selecting 
Tools>Options>Processor Defaults>Defaults>Meter Clipping, and setting the 
Clip Threshold to a number between 0 (dB) and – 20 (dB). 

NOTE:	 When the Clip Threshold is set to 0 (dB), clipping is indicated only when 
clipping occurs.

Meters within the DSP Configurator are peak-type meters, referenced to full scale, or 
0 dBFS. For the DMP 64 outputs, 0 dBFS corresponds to +21 dBu, the maximum output 
level of the device. Maximum input level is +24 dBu. Gain from – 3 dB to +80 dB is applied 
in the analog domain, while attenuation from – 3 dB to –18 dB is applied in the digital 
domain. The input meters are post-ADC, while the output meters are pre-DAC.

The remainder of this section will reference the gain, trim and volume controls outlined in 
figure 58 below. 

a c d eb

Figure 58.	 Gain, Trim and Volume Controls

a	Mic/Line input gain	        d	Post-mixer trim 

b	Pre-mixer gain 		         e	Output volume

c	Mix-point gain
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About Setting Gain Structure
There are two approaches the system designer can take in setting up gain structure, 
depending upon where output volume is to be controlled. The output volume of the 
DMP 64 can be controlled by either of the following two gain blocks (see figure 58 on the 
previous page):

•	 Volume (e) and

•	 Pre-mixer gain (b). 

NOTE:	 While the pre-mixer gain control is not in the output signal chain, it can 
be used to control program level independent of mix-point levels.

In the following instructions, setup is described for output volume or pre-mixer gain when 
appropriate.

Setting Input Gain
Floating point DSP technology is internally more flexible than fixed point. However, the 
input ADCs and output DACs always run as fixed point, so it is important to optimize 
the audio by setting the input level as close to 0 dBFS as possible. This maintains the 
resolution at 24-bit. Within the DSP it is not critical to maintain audio levels at 0 dBFS in 
order to secure the resolution at 24-bit.

Input gain can be set using the intended input source device and typical source material 
for the installation. When source material is not available, it can be set using pink noise 
obtained either from a pre-recorded track on a DVD or CD, or a signal generator. 

For program material, set the input gain level (see figure 58, a) so the meters reach 
–15 to –12 dBFS, with peaks at approximately – 5 to – 3 dBFS. This setting provides 
enough headroom to accommodate transients or unanticipated loud events in the 
program material to avoid clipping. 

When using pink noise, it should be recorded at – 20 dBFS. If the player has an output 
level setting control, set the output of the player to its maximum, or 0 dB of attenuation. 

NOTE:	 If the maximum output setting provides gain, back the control down slightly 
from the maximum setting. 

When using a signal generator, set the output at –10 dBu. 

Whichever pink noise source is used, set the input gain in the DSP Configurator so the 
input meter reads – 20 dBFS. 

Setting a Nominal Output Level
In order to set up a gain structure to include signal processing, listening to the audio can 
be advantageous. Route the audio that carries program material from the source to the 
speakers in the room being set up. With the output volume control (see figure 58, e) set 
to – 20 dB, set the external amplifier so the source material plays at a volume level that is 
reasonably loud, but tolerable. 

NOTE:	 When using the volume control for this purpose, set post-mixer trim (d) to 
0 dB. If using the post-mixer trim for this purpose, set volume to 0 dB (100%).

Verify the amplifier is not clipping by observing the amplifier clip indicator. This sets the 
amplification (volume) nominal level of the system, and if desired, allows listening while 
making adjustments. Adjust or mute the volume control as necessary (see Setting 
Volume Control for the Amplifier Stage on page 91). 

 

DMP 64 • Software Control 89



Adjusting Pre-mixer Gain
After setting input gain, add desired processors into the input signal chain (see figure 58 
on page 88). The pre‑mixer gain control (b) is used to compensate for level changes due 
to processing. Adding a compressor generally reduces the signal level, while a filter can 
boost or cut the overall signal level. When changes are made to filter settings after setting 
dynamics processors, re‑check the levels in the dynamics processors to make certain 
they are still valid.

NOTE:	 This procedure is valid only when there is no active processing in the output 
signal path and if the post-matrix trim value is set to 0 dB, unity gain. If processors 
are inserted in the output signal path, engage Bypass to temporarily remove them.

To adjust pre-mixer gain:

1.	 Open the line input gain (a), output volume (e), and pre-mixer gain (b) dialog boxes. 

2.	 Connect program material (or pink noise) at the input.

3.	 Set the output volume to 100% (mute if necessary). 

4.	 Adjust the pre-mixer gain (b) so the meter level on the input gain dialog matches the 
meter level of the output volume dialog. This maintains the audio at an optimal level in 
the input signal chain. 

This sets a good starting point. After setting up the microphone input gain and mix‑point 
levels, output processing, and trim levels, if more headroom is required to prevent clipping 
at the outputs, return to the pre-mixer gain controls (b) and lower each one by specific 
amounts. Further minor adjustments to the pre-mixer gain controls help to balance 
perceived audio levels of the different inputs.

When using the pre-mixer gain for output volume control, the procedure can be reversed. 
Set pre-mixer gain to 0 dB. With program material (or pink noise) present at the input, 
adjust the output volume until the meter level in the output volume dialog box is below 
clipping (or ideally, matches the level at the input gain meter).

Setting Output Gain Structure
Add all desired processors into the output signal chain. Keep in mind that a filter can 
boost or cut the overall signal level and adding a compressor generally reduces the signal 
level. Inserting either or both can require resetting of the output volume. 

Since a limiter is the most likely choice for output processing and can only reduce the 
signal to prevent overload, a reduction of output level does not have to be considered. 
Loudness boosts the overall signal level, but only at lower volume settings. 

After adding processors to the output signal chain, the output volume level can clip when 
set to 100% (or less). Floating point DSP allows clipping to be overcome by lowering 
the output volume (e) setting. However, unless a user is prevented from changing the 
volume setting to 100% (or to any position where clipping occurs), it is best to adjust the 
pre‑mixer gain (b) or post-mixer trim (d) control to prevent any possible clipping. 

Alternately, use the post-mixer trim controls to adjust output volume. Post-mixer trim 
controls provide 12 dB of gain, so use a group master with soft limits to control levels, 
setting an upper limit of 0 dB or less. Mic levels also contribute to clipping at the outputs, 
and can need lowered to maintain the balance between program material (line outputs) 
and voice.
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Setting Mic/Line Input and Mix Levels
In this example, the mic/line input 1 signal is sent to output 1 (see figure 58 on page 88). 

To set the mic/line input and mix levels:

1.	 Connect a microphone to input #1.

2.	 Double-click the mix‑point (c) for mic/line 1 to output 1 to open the dialog for that 
mix-point, then unmute the mix‑point to place the signal into the mix. 
The default level for the mix-point is 0 dB, or unity gain.

3.	 Open the Input 1 Gain (a) dialog and set gain to 0 dB (turn on phantom power if the 
mic requires it), then unmute the channel. 

4.	 While testing the mic, raise the fader level until the mic is clearly audible. The amount 
of gain and the meter level vary at this point, but as a general guideline the input 
gain level should be at 40 to 50 dB, with the meter averaging somewhere around 
– 20 dBFS. 

Ideally, audio will be optimized here, but voice levels at microphone inputs can vary greatly. 
Having the meters average around – 20 dBFS allows enough headroom to accommodate 
sudden changes to voice levels. Further adjustment can be necessary.

Adjusting Trim
This is where setting gain structure becomes a balancing act. The following sections 
provide guidelines, but it can take a bit of going back and forth to correctly set levels for 
the installation. For example, output level can be controlled and kept below clipping using 
a compressor or limiter in the output dynamics block. However, adjusting the post-matrix 
trim will affect how the compressor or limiter works.

1.	 Apply program material (or pink noise) at the input to be adjusted. 

2.	 Open the output Volume (e) and post-matrix Trim (d) dialog boxes. 

3.	 Set output volume to 100% (mute if necessary). 

4.	 Adjust the post-matrix trim until the meter level in the output volume dialog is below 
clipping (or ideally, matches the level at the input gain meter). 

This maintains the audio at an optimal level in the output signal chain while preventing 
clipping at the output. 

Setting Volume Control for the Amplifier Stage
The maximum output of the DMP 64 is +21 dBu. As an example, assume the maximum 
input level of a power amp is +4 dBu with its input attenuator fully open. If using the 
output Volume control (e) of the DMP 64 to control volume levels, turn down the input 
attenuator of the power amp the equivalent of 17 dB (21 – 4 = 17) to ensure clipping does 
not occur at the amplifier. That puts the amplifiers input level at –13 dB (+4 – 17 = –13). 
If the amplifier setting (when the output volume controls of the DMP 64 are at maximum) 
is too loud for the room, it can need to be reduced further. If it is not loud enough for the 
room, a more powerful amplifier can be required.

Extron recommends using the output volume or post-mixer trim control on the DMP 64 
for controlling output volume. When using loudness processing on the unit, it only works 
in conjunction with these controls. 

When using the power amplifier input attenuation to control volume (using the same 
power amp maximum input level), set the output volume or post-mixer trim control of the 
DMP 64 to –17 dB. This is another way that clip points of the two devices are matched. 
Verify the amplifier is not clipping by observing the amplifier clip indicator. 

NOTE:	 Using the amplifier input attenuation to control volume compromises the 
signal-to-noise ratio of the DMP 64 and is not recommended.
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SIS Programming 
and Control

This section describes SIS programming and control of the DMP 64, including:

•	 Connection Options

•	 Host-to-device Communications

•	 Command and Response Table for Basic SIS Commands

•	 Command and Response Tables for DSP SIS Commands

•	 Special Characters

Connection Options
The DMP 64 Digital Matrix Processor can be remotely connected via a host computer or 
other device (such as a control system) attached to the rear panel RS‑232 port or LAN 
port, or the front panel USB Config port. 

The DMP 64 can be set up and controlled using SIS commands, embedded web pages, 
or DSP Configurator software. See Installation on page 5 for pin assignments 
and details on the configuration and control port connections. For information on 
DSP Configurator, see DMP Software on page 14, and for the embedded web pages, 
see HTML Operation on page 120.

SIS commands can be executed using the Extron Electronics DataViewer program, found 
on the Software Products DVD included with the product.

DMP 64 RS-232 protocol: 

•	 38400 baud •	 no parity •	 1 stop bit

•	 8 data bits •	 no flow contro

NOTE:	 Both rear panel configuration ports require 38400 baud communication. This 
is a higher speed than many other Extron products use. When using HyperTerminal 
or a similar application, make sure the PC or control system connected to these 
ports is set for 38400 baud.

For additional details on connecting the RS‑232 port, see RS-232 Ports on page 93.

USB port details: 
The Extron USB driver must be installed before the USB port can be used (see Install the 
USB Driver on page 17).

LAN port defaults: 

DMP 64 IP address: 192.168.254.254

gateway IP address: 0.0.0.0

subnet mask: 255.255.0.0

DHCP: off
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RS-232 Ports
The DMP 64 has two serial ports that can be connected to a host device such as a 
computer running the HyperTerminal utility or DataViewer. The ports make serial control 
of the switcher possible. Use the protocol information listed to make the connection. 
For SIS programming details once the connection is made, see Host-to-device 
Communications on page 95.

USB Port (Front Panel)
The DMP 64 has a front panel USB port that can be connected to a host device such as 
a computer running the HyperTerminal utility, or the DataViewer utility. The port makes 
serial control of the switcher possible. For SIS programming details once the connection is 
made, see Host-to-device Communications on page 95. 

Ethernet (LAN) Port
The rear panel LAN connector on the device can be connected to an Ethernet LAN or 
WAN. Communication between the device and the controlling device is via Telnet (a 
TCP socket using port 23). The Telnet port can be changed, if necessary, via SIS. This 
connection makes SIS control of the device possible using a computer connected to the 
same LAN or WAN. The SIS commands and behavior of the product are identical to the 
commands and behavior the product exhibits when communicating via a serial port or 
USB.

Ethernet Connection

The Ethernet cable can be terminated as a straight-through cable or a crossover cable 
and must be properly terminated for your application (see figure 59).

12345678

RJ-45
Connector

Insert Twisted
Pair Wires

Pins:

A cable that is wired as TIA/EIA T568A at one 
end and T568B at the other (Tx and Rx pairs 
reversed) is a "crossover" cable.

A cable wired the same at both ends is called 
a "straight-through" cable because no pin/pair 
assignments are swapped.

T568A T568B T568B T568B

Straight-through Cable
(for connection to a switch, hub, or router)

 End 1 End 2
 Pin Wire Color Pin Wire Color

  1 white-orange 1 white-orange
 2 orange 2 orange
 3 white-green 3 white-green
 4 blue 4 blue
 5 white-blue 5 white-blue
 6 green 6 green
 7 white-brown 7 white-brown
 8 brown 8 brown

Crossover Cable
(for direct connection to a PC)

 End 1 End 2
 Pin Wire Color Pin Wire Color

 1 white-orange 1 white-green
 2 orange 2 green
 3 white-green 3 white-orange
 4 blue 4 blue
 5 white-blue 5 white-blue
 6 green 6 orange
 7 white-brown 7 white-brown
 8 brown 8 brown

Figure 59.	 RJ-45 Ethernet Connector Pin Assignments
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To establish a network connection to the DMP 64:

1.	 Open a TCP socket to port 23 using the mixer IP address.

NOTE:	 If the local system administrators have not changed the value, the 
factory‑specified default, 192.168.254.254, is the correct value for this field.

2.	 The DMP 64 responds with a copyright message including the date, the name of the 
product, firmware version, part number, and the current date and time.

a.	 If the DMP 64 is not password-protected, the device is ready to accept SIS 
commands immediately after it sends the copyright message.

b.	 If the DMP 64 is password-protected, a password prompt appears below the 
copyright message. Proceed to step 3.

3.	 If the device is password protected, enter the appropriate administrator or user 
password.

a.	 If the password is accepted, the device responds with Login User or Login 
Administrator.

b.	 If the password is not accepted, the Password prompt reappears. Repeat step 3.

Connection Timeouts

The Ethernet link times out after a designated period of time of no communications. By 
default, this timeout value is set to 5 minutes but the value can be changed. See the 
Configure Port Timeout commands in the “Command and Response Table for 
Basic SIS Commands” beginning on page 98.

NOTE:	 Extron recommends leaving the default timeout at 5 minutes and periodically 
issuing the Query (Q) command to keep the connection active. If there are long idle 
periods, disconnect the socket and reopen the connection when another command 
must be sent.

Verbose Mode
Telnet connections can be used to monitor for changes that occur, such as SIS 
commands from other Telnet sockets or a serial port. For a Telnet session to receive 
change notices, the Telnet session must be in verbose mode 1 or 3. In verbose mode 
1 or 3, the Telnet socket reports changes in messages that resemble SIS command 
responses.
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Host-to-device Communications
The commands listed in the following tables perform the same functions, but are encoded 
differently to accommodate the requirements of each port (Telnet or browser).

DMP 64-initiated Messages
The DMP 64 initiates messages under specific conditions. No response is required from 
the host. The DMP 64-initiated messages are listed here (underlined).

© Copyright 2009, Extron Electronics, DMP 64, Vn.nn, 60–1054-01 
Day, DD MMM YYYY HH:MM:SS 
Vn.nn is the firmware version number. 
The DMP 64 sends the boot and copyright messages under the following circumstances:

•	 If the DMP 64 is off and an RS-232 connection is set up (the PC is cabled to the 
DMP 64 and a serial communication program such as HyperTerminal is open), the 
connected unit sends these messages by RS-232 when first powered on.

•	 If the DMP 64 is on, it sends the boot and copyright messages when a Telnet 
connection to the DMP 64 is first opened. The day of the week, date, and time are 
shown when the DMP 64 is connected by Telnet, but not by RS-232. If using a Telnet 
connection, the copyright message, date, and time are followed by a password 
prompt.

Password Information
The ]Password: prompt requires a password (administrator level or user level) followed 
by a carriage return. The prompt is repeated if the correct password is not entered.

If the correct password is entered, the unit responds with ]Login Administrator ] 
or ]Login User], depending on the password entered. If passwords are the same for 
both administrator and user, the unit will default to administrator privileges.

SIS commands consist of a string (one or more characters per command field). No 
special characters are required to begin or end a command sequence. When the DMP 64 
determines a command is valid, it executes the command and sends a response to 
the host device. All responses end with a carriage return and a line feed (CR/LF = ]), 
signaling the end of the response character string.

When programming, certain characters are more conveniently represented by their 
hexadecimal rather than ASCII values. The table below shows the hexadecimal equivalent 
of each ASCII character:

• 

Space

l

I

ASCII to HEX  Conversion Table

Figure 60.	 ASCII to Hex Conversion Table
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The Command and Response tables list valid ASCII (for Telnet or RS-232) command 
codes, the corresponding URL (Uniform Resource Locator) encoded (for Web browsers) 
command codes, the DMP 64 responses to the host, and a description of the command 
function or the results of executing the command.

Symbol definitions

] = CR/LF (carriage return/line feed) (hex 0D 0A)

}
=

Carriage return (no line feed, hex 0D)   
(for URL-encoded commands, use the pipe character, | , 
instead)

• = Space character (%20 for web browser)

| = Pipe (vertical bar) character

* = Asterisk character (which is a command character, not a 
variable)

E = Escape key (hex 1B)  
(use W instead of Esc for Web browsers)

NOTE:	 For Web encoding only: data is directed to the specified port and must be 
encoded (URL encoding) if it is non-alphanumeric. Change any non‑alphanumeric 
character (%, +, |, }, and so on) within the data section into the corresponding 
hexadecimal equivalent, %xx, where xx represents the two-character hex byte. For 
example, a space (hex: 20) would be encoded as %20 and a plus sign (hex: 2B) 
would be encoded as %2B.

Error Responses
When the DMP 64 is unable to execute the command, it returns an error response to the 
host. The error response codes and their descriptions are as follows:

E01 - Invalid input number (number is too large) E23 - Checksum error (for file uploads)

E12 - Invalid port number E24 - Privilege violation

E13 - Invalid parameter (number is out of range) E25 - Device is not present

E14 - Not valid for this configuration E26 - Maximum connections 
exceeded

E17 - System timed out E27 - Invalid event number

E22 - Busy E28 - Bad filename or file not found
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Simple Control Port Commands - Telnet and Web-browser Accessible
Upper and lower case text can be used interchangeably except where noted. Port 23 
is default for Telnet. Port 80 is default for Web browser. They both can be mapped to 
different ports.

The following commands are for either a Telnet (port 23) or web browser (port 80) 
connection. There are minor differences when implementing these commands via Telnet 
or via URL encoding using a Web browser. All commands listed will work using either 
connection method but due to some limitations of the Web browser, the encapsulation 
characters must be modified to be certain the Web browser will properly handle them. All 
examples are shown in a proper implementation of a Telnet or web browser session. 

NOTE:	 When using Web browsers, some non-alpha numeric characters must be 
represented as their hex equivalent such as %xx where xx equal the two character 
representation of the hex byte that needs to be sent (for example, a comma ‘,’ 
would be represented as %2C). Characters such as ‘%’ (percent), ’+’ (plus) and ‘ ‘ 
(space) should also be encoded in Hex. 

Telnet Web Browser
Escape (Hex 1B) W [must not be encoded]

Carriage Return (Hex 0D) Pipe Character (>) [must not be encoded]

When describing the use of SIS commands via a web browser, the [URL] reference is 
used to shorten the examples. [URL] would be the full URL of the control interface and 
web page reference including all path information  
(for example, http://192.168.254.254/mypage.HTML).

To send commands using a web browser, prefix them with the full URL followed by 
?cmd=  (for example, http://192.168.254.254/mypage.html?cmd=WSF>).

ASCII Hex Unit response
Control Command 
(via Telnet)

Esc X# X@ Command } 
X@ Data

1B X# X@ Command 0D 
X@ Data 

response from command 

]

Example: Esc 03RS } 1*2! 1B 30 33 52 53 0D 
31 2A 32 21

OUT 02•IN 01• ALL ] 

ASCII URL Encoded (Web) Unit response
Control Command 
(via WEB)

URL?cmd=W X# X@ 
Command > X@ Data 

URL?cmd=W X# X@ 
Command > X# X@ Data 

response from command ]

Example: URL?cmd=W03RS>1*2! URL?cmd=W03RS > 
1%2A2%21

OUT 02•IN 01• ALL]

NOTES:	 X@   =	 Input number, 1 through 6 
	 X#   = 	Output number 1 through 4

Although the DMP 64 uses the same structure for SIS commands, there are two 
variations. One is the global command structure noted above and documented in the 
Command and Response Table for Basic SIS Commands on page 98.

The second set of tables uses the command structure outline beginning with Command 
and Response Tables for DSP SIS Commands on page 103. While using the same 
structure of basic SIS commands, they differ in how the software addresses the individual 
processor blocks within the DMP 64. 

Generally, the basic SIS commands are used for global configuration such as setting 
IP addresses, date/time, while the DSP SIS commands allow functionality of the audio 
signal chain.

 

DMP 64 • SIS Programming and Control 97



Command and Response Table for Basic SIS Commands
Command ASCII command

(host to device)
URL Encoded
(web)

Response
(device to host)

Information requests
Firmware Version Q *Q X1!]
Firmware and build version *Q *Q X1!]
Kernel firmware and build **Q **Q X1!]
Verbose version info 0Q 0Q Sum of 2Q-3Q-4Q]
Firmware version 1Q 1Q X1!]
Bootstrap Version 2Q 2Q X1!]
Factory Firmware Version 3Q 3Q X1! plus web ver.-desc-UL 

date/time]
Updated firmware version 4Q 4Q X1! plus web ver.-desc-UL 

date/time]
NOTE:	 An asterisk (*) after the version number indicates the currently running version. Question marks (?.??) indicate that 

only factory firmware is loaded. A caret (^) indicates the firmware version that should be running, but a Mode 1 reset 
was executed and the default factory firmware is running. An exclamation point (!) indicates corrupted firmware.

Query part number N N 60–1054-01 ]
Query model name I I V00x00•A06x04]
Query model name 1I 1I DMP•64]
Query model description 2I 2I Digital•Matrix•Processor]
Query system memory 
usage

3I 3I #Bytes used out of 

#KBytes]
Query user-memory usage 4I 4I #Bytes used out of 

#KBytes]

NOTE:	 X1! = Version number	 Firmware version number to second decimal place (x.xx) 
				    Version and Build number adds four digits (x.xx.xxxx) 
				    to the Version number
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Command and Response table for basic SIS commands (continued)

Command ASCII command
(host to device)

Response
(device to host)

Additional 
description

IP Setup Commands

Set unit name EX1@CN} Ipn•X1@]
View unit name ECN} X1@]
Set name to factory default E•CN} Ipn•X4(]
Set time and date EX1#CT} Ipt•X1#]
View time and date ECT} X1#]
Set GMT offset EX#CZ} IpzX#]
View GMT offset ECZ} X#]
Set Daylight Saving Time EX3$CX} IpxX3$]
Read Daylight Saving Time ECX} X3$]
Set IP address EX1$CI} IpiX1$]
Read IP address ECI} X1$]
Read hardware address 
(MAC)

ECH} X1*]

Set subnet mask EX1(CS} IpsX1(]
Read subnet mask ECS} X1(]
Set gateway IP address EX1$CG} IpgX1$]
View gateway IP address ECG} X1$]
Set DHCP on E1DH} Idh1]
Set DHCP off E0DH} Idh0]
NOTE:	 Changing DHCP from On to Off resets the IP address to the factory default (192.168.254.254)
View DHCP status EDH} X%]
Set verbose mode EX2@CV} VrbX2@]
View verbose mode ECV} X2@]
Get connection listing ECC} [number of connections]]

NOTES:	 X# = Greenwich Mean Time offset	 GMT offset value (–12:00 to 14:00) representing hours and minutes 
						      (HH:MM) local time is offset from GMT time
	 X% = On/Off status		  0=off/disable
						      1=on/enable
	 X1@ = Unit name			   Alpha-numeric up to 24 characters. No special characters except hyphen (-)
						      No upper/lower case distinction, no blanks or spaces, first character must be
						      alpha, last character cannot be hyphen.
	 X1# = Local date/time		  Set: MM/DD/YY-HH:MM:SS
						      Read: day of week, date, month, year HH:MM:SS  

					     (Example: Fri, 21 Jun 2002 10:54:00)
	 X1$ = IP Address			  default 192.168.254.254
	 X1* = Hardware MAC address	 00-05-A6-xx-xx-xx
	 X1( = Subnet mask		  Default 255.255.0.0
	 X2@ = Verbose/Response mode	 0=clear  

					     1=verbose  
					     2=tagged responses,  
					     3=verbose + tagged responses

	 X3$ = Daylight Saving time		  0=off/ignore ; 
						      1= USA (begins first Sunday in April/ends last Sunday in October); 
						      2= Europe (begins last Sunday in March/ends last Sunday in October);
						      3= Brazil (begins third Sunday in October/ends third Saturday in March).
	 X4( = Alpha-numeric unit name	 combination of unit name and last three pairs of MAC address
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Command and Response table for basic SIS commands (continued)

Command ASCII command
(host to device)

Response
(device to host)

Additional 
description

Password and Security Settings

Set administrator password EX3#CA} Ipa•X4!]
View administrator 
password

ECA} X4!]

Reset (clear) administrator 
password

E•CA} Ipa•]

Set user password EX3#CU} Ipu•X4!]
View user password ECU} X4!]
Reset (clear) user password E•CU} Ipu•]
Query session security level ECK } X5@]

Ethernet Data Port

Set current port timeout E0*X6(TC} Pti0*X6(]
View current port timeout E0TC} X6(]
Set global IP port timeout E1*X6(TC} Pti1*X6(]
View global IP port timeout E1TC} X6(]

File Commands

Erase user-supplied web 
page file

E filename EF } Del•filename ]

Erase current directory E/EF } Ddl] Also deletes files inside 
directory

Erase current directory and 
sub-directories

E//EF } Ddl] filename x•date/time•length

List files from current 
directory

EDF } filename x•date/time•length] 

filename x•date/time•length] 

filename x•date/time•length] 

... space_remaining•Bytes Left]]

List files from current 
directory and below

ELF } filename x•date/time•length] 

filename x•date/time•length] 

filename x•date/time•length] 

... space_remaining•Bytes Left]]

NOTE:	 LF has the same response from unit as DF command, except the directory path will precede filenames for files from 
directories below the current directory. 

NOTES:	 X3# = 12 alpha-numeric characters	  
X4! = alpha-numeric password	 returns four **** to mask password 
X5@ = Security level of connection	 0=anonymous, 11=user, 12=administrator 
X6( = IP connection timeout	 1-65000 steps, (1 step=10 seconds) 
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Command and Response table for basic SIS commands (continued)
Command ASCII command

(host to device)
Response
(device to host)

Additional 
description

Serial Port

Send Data String EX!*X1&*X2)*X2!RS} X@ response]
Configure parameters EX!*X2%,X2^,X2&,X2*CP} CpnX!•CcpX2%,X2^,X2&,X2*]
View serial port parameters EX!CP} X2%,X2^,X2&,X2*]
Configure rcv timeout EX!*X1&*X2)*X2#*X2!CE} CpnX!•CceX1&, 

X2),X2#,X2!]
View receive timeout EX!CE} X1&,X2),X2#,X2!]

NOTES: X! = Port Number 01-99 represented by 2 Bytes (ASCII). 

X@ = Command data section NOTE: 	For web encoding only: Data will be directed to specified port and 
must be encoded if non-alpha numeric. Since data can include either 
command terminator, they must be encoded as follows when used 
within the data section:   
Space (Hex: 20) would be encoded as %20 and  
Plus sign (Hex: 2B) would be encoded as %2B

X1& = Command string wait time 0-32767 in tens of milliseconds

X2) = Character wait time 0-32767 in tens of milliseconds

X2! = Length of stream or delimiter L=Byte Count (00 – 32767) 
D=decimal value for ASCII character (0-00255)

X2# = Priority status for receiving 
timeouts (Default=0)

0=Send data string command parameters if they exist 
1=Configure receive timeout command parameters instead.

X2% = Baud Rate (Default=9600) 300,600,1200,1800,2400,3600,4800,7200,9600,14400,1
9200,38400,57600,115200

X2^ = Parity (Default=N=none) O=odd          E=even 
N=none        M=mark 
S=Space

X2& = Data bits (Default=8) 7, 8

X2* = Stop bits (Default=1) 1,2

Command ASCII command
(host to device)

Response
(device to host)

Additional 
description

Event Control

Read event buffer memory EX3%,X3^,X3&,X3*E } X5$]
Write event buffer memory EX3%,X3^,X3(,X3*E } Evt X3%,X3^,X3&,X3(]
NOTE:	 Response to Write Event is padded with leading zeros for X3% & X3&.
Read string from event 
buffer

EX3%,X3^,X3&,X4$FE {string}]

Write string to event buffer E{string}*X3%,X3^,X3&FE
NOTE:	 ‘F’ must be capitalized to read and write strings to event buffer memory. 

Response to Write Event is padded with leading zeros for X3% & X3&.
Start events E1AE } Ego]
Stop events E0AE } Est]
Query # of running events EAE } #####] (5 digit number)

NOTES:	 X3% = Event number		  range 00-99 
X3^ = Event buffer		  0=receive 
					     1=Unified 
					     2=data 
					     3=NVRAM 
X3& = Event buffer offset		  range: 0 to Max buffer size 
X3* = Event data size (case sensitive)	 b=bit, B=Byte (8-bit), S=short (16-bit), L=long ((32-bit) 
X3( = Event data to write	      
X4$ = number of Bytes to read	 range 1–127 
X5$ = Data element read		  ASCII digit(s) representing numeric value of data elements read from buffer 
					     (leading zeros suppressed) 

NOTES: X! = Port Number 01-99 represented by 2 Bytes (ASCII). 

X@ = Command data section NOTE: 	 For web encoding only: Data will be directed to 
specified port and must be encoded if non-alpha 
numeric. Since data can include either command 
terminator, they must be encoded as follows when 
used within the data section:   
Space (Hex: 20) would be encoded as %20 and  
Plus sign (Hex: 2B) would be encoded as %2B

X1& = Command string wait time 0-32767 in tens of milliseconds

X2) = Character wait time 0-32767 in tens of milliseconds

X2! = Length of stream or delimiter L=Byte Count (00 – 32767) 
D=decimal value for ASCII character (0-00255)

X2# = Priority status for receiving 
timeouts (Default=0)

0=Send data string command parameters if they exist 
1=Configure receive timeout command parameters instead.

X2% = Baud Rate (Default=9600) 300,600,1200,1800,2400,3600,4800,7200,9600,14400,1920
0,38400,57600,115200

X2^ = Parity (Default=N=none) O=odd 
E=even 
N=none 
M=mark 
S=Space

X2& = Data bits (Default=8) 7, 8

X2* = Stop bits (Default=1) 1,2
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Command and Response table for basic SIS commands (continued)

Command ASCII command
(host to device)

Response
(device to host)

Additional description

Presets, I/O Names
Write preset name EX1),X1!NG} NmgX1),X1!]

Example: E1,Security1NG} Nmg01,Security1] Name preset 1 “Security 1”

Read preset name EX1)NG} X1!]
Example: E2NG} Security2]

Recall a preset X1). RprX1)] Command character is a 
period.

Example 5. RprX1)] Recall preset 5, which 
becomes the current 
configuration.

Write input name EX#,X1!NI} NmiX#,X1!]
Example: E9,Podium cam1NI} Nmi09,Podium cam1] Name input 9 “Podium cam1”

Read input name EX#NI} X1!]
Write output name EX@,X1!NO} NmoX@,X1!]

Example: E1,Main PJ1NO} Nmo01,Main PJ1] Name output 1 “Main PJ1”

Read output name EX@NO} X1!]

Resets
Reset presets and names EZG} Zpg] Clear all presets and their 

names.
Reset an individual preset EX1)ZG} ZpgX1)] Clear preset X1).
Reset a group EZX2)GRPM} GrpmZX2)] Delete all members from 

group X2), reset parameters 
and soft limits.

NOTE:	 See Group Masters on page 69, for more information about audio group masters.
Reset flash EZFFF} Zpf] Reset flash memory 

(erase user-supplied files).
System Reset (factory 
defaults)

EZXXX} Zpx] Resets all processors, level 
controls and mixers to default.

Reset all device settings 
and delete files

EZY} Zpy]

NOTE:	 This reset excludes IP settings such as IP address, subnet mask, gateway IP address, unit name, DHCP setting and 
port mapping (telnet/web/direct access) in order to preserve communication with the device.  
This reset is recommended after a firmware update.

Absolute reset EZQQQ} Zpq] Similar to System Reset, 
plus sets the IP address 
to 192.168.254.254 
and the subnet mask to 
255.255.0.0.

NOTES:	 X# = Input number		  01 – 06
	 X@ = Output number		  01 – 04 
	 X1) = Preset #			   32 maximum (0 = current configuration)
	 X1! = Name			   12 characters maximum
	 X2) = Group master group number	 01 – 32
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Command and Response Tables for DSP SIS Commands
Many digital signal processor (DSP) functions; gain, mute, group masters, and a protected 
configuration can be controlled using SIS commands. These commands follow the same 
general rules as basic SIS commands, but the variables (X/) tend to be more complex. 
Also, a comprehensive understanding of the audio signal flow is helpful to understanding 
the commands. Figure 61 shows specific DSP functions available using SIS commands. 

NOTE:	 The entire signal flow is described in more detail in the DSP Configurator 
program section (see Windows-based Program Control on page 15).

a b c e

f

d

Ñ
Figure 61.	 DSP Processors Addressable by SIS Commands

a	 Mic/line input gain block (including gain and mute)

b	 Pre-mixer gain block (including gain and mute)

c	 Mix-points (including gain and mute)

Ñ	 Virtual return mix-points

d	 Post-mixer trim block (gain only)

e	 Output volume (including gain and mute)

f	 Virtual return gain
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Symbol definitions

] = CR/LF (carriage return/line feed) (hex 0D 0A)

} = Carriage return (no line feed, hex 0D)  
(use the pipe character, | , for Web browser commands)

• = Space character

| = Pipe (vertical bar) character

E = Escape key (hex 1B)  (use W instead of Esc for Web browsers)

X6) = Gain and trim control or mix-point select See the tables on page 107.

X6! = Level value;  
mix-point gain  (c), and 
post-mixer trim (d)

See the table on pages 109, 110, and 111. 
-35 dB to + 25 dB, (1698 to 2298 ) in 0.1 dB increments. 

NOTE:	 Post-mixer, –12 dB to +12 dB (1928 to 2168) only.

X6@ = Mic/line gain (a) level value See the table on pages 112, 114, and 115. 
–18.0 dB to +80 dB, (1868 to 2848 ) in 0.1 dB increments.

X6# = Level value: 
pre-mixer gain  (b), and 
output volume (e)

See the table on pages 116, 117, 118, and 119. 
–100.0 dB to +12.0 dB, (1048 to 2168) in 0.1 dB increments.

NOTE:	 Output volume, –100.0 dB to +0.0 dB (1048 to 2048 ) only.

X6$ = Mute status 0 = unmute 
1 = mute

X6% = Group master group number 01 – 32 

X6^ = Group fader setting dB value, in 0.1 dB increments using negative numbers but not decimal places. 
The valid range depends on the type of gain block that is assigned to the group 
number (X6%) specified in the command: 
a = –180 to 800  (–18.0 dB to +80.0 dB) 
b = –1000 to 120  (–100.0 dB to +12.0 dB) 
c = -350 to 250  (-35.0 dB to + 25.0 dB) 
d = –120 to 120  (–12.0 dB to +12.0 dB) 
e = –1000 to 000  (–100.0 dB to +0.0 dB)

NOTE:	 Leading zeros are ignored.

X6& = Group fader increment dB value, in 0.1 dB increments, to raise or lower a group fader

X6* = Group fader soft limit dB value, in 0.1 dB increments. The valid range X6^ must be within the range 
for the gain block grouped in X6%.

X6( = Group type   6 = gain 
12 = mute

X7) = Personal Identification Number (PIN) Four numeric digits, default = 0000

X7! = Protected configuration status 0 = no protected configuration saved 
1 = protected configuration saved

Special Characters
The HTML language reserves certain characters for specific functions. The device will not 
accept these characters as part of preset names, the device name, passwords, or locally 
created file names.

The DMP 64 rejects the following characters: 
{space (spaces are OK for names)}  +  }  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  ;  :  >  \  ?
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Command and Response Table for DSP SIS Commands

Command ASCII command
(host to device)

Response
(device to host)

Additional description

Audio Level Control, and Mix-point Selection

NOTE:	 The command format is the same, regardless of the control or mix-point to be set; the acceptable adjustment 
range varies depending on the control or mix-point:

	 	 • The mic/line input gain range is – 18 dB to +80 dB, in 0.1 dB increments. 
	 • The pre-mixer gain range is –100 dB to +12 dB, in 0.1 dB increments. 
	 • The main mix-points range –35 dB to +25 dB, in 0.1 dB increments. 
	 • The post-mixer trim range is –12 dB to +12 dB, in 0.1 dB increments. 
	 • The output volume range is –100 dB to 0 dB, in 0.1 dB increments.

	 All responses are shown with the DMP 64 in Verbose mode 2 or 3.

Set a trim or gain (excluding 
mic/line inputs)

EGX6)*X6!AU} DsGX6)*X6!] Set trim or mix control X6) to 
a value of X6! dB.

Example 1 (pre-mixer 
gain):

EG40105*2040AU} DsG40105*2040] Set the #6 pre-mixer gain to a 
value of -0.8 dB.

Example 2 (mix-point 
gain):

EG20001*2213AU} DsG20001*2213] Mix +16.5 dB of mic 1 into 
output 2.

Set a mic/line gain EGX6)*X6@AU} DsGX6)*X6@] Set mic/line gain control X6) 
to a value of X6@ dB.

Example: EG40001*2288AU} DsG40001*2288] Set the mic/line input 2 gain 
to a level of +24.0 dB.

Set Output Volume EGX6)*X6#AU} DsGX6)*X6#] Set output volume control 
X6) to a value of X6# dB.

Example: EG60000*1548AU} DsG60000*1548] Output 1 volume set to a level 
of -50.0 dB.

Read a trim or mix 
(excluding mic/line inputs)

EGX6)AU} DsGX6)*X6!] DSP trim or mix control X6) is 
set to a value of X6! dB.

Example 1 
(post mixer gain control):

EG60101AU} DsG60101*2103] Output 2, post mixer trim is 
set to a value of +5.5 dB.

Example 2 (mix control): EG20203AU} DsG20203*2140] +9.2 dB of mic 3 is mixed into 
output 4.

Read a mic/line gain EGX6)AU} DsGX6)*X6@] Mic/line gain control X6) is 
set to a value of X6@ dB.

Example: EG40000AU} DsG40000*2598] Mic/line input 1 gain is set to a 
value of +55.0 dB.

Audio Mute

NOTES:	
•	 The post-mixer trim cannot be muted.

•	 All responses are shown with the mixer device in Verbose mode 2 or 3.

Audio mute EMX6)*1AU} DsMX6)*1] Mute audio point X6).
Example: EM20301*1AU} DsM20301*1] Mute mix-point input 4 to 

output 2.
Audio unmute EMX6)*0AU} DsMX6)*0] Unmute audio point X6).
Read audio mute or level EMX6)AU} DsMX6)*X6$]

NOTES:	 X6) = Audio level control, or mix-point select		  See table 1 on page 111 and 112.
	 X6! = Level value; mix-point or post-mixer trim		  See tables 2, 3, and 4 on page 113 through 115. 

X6@ = Mic/line gain level value			   See table 5 on page 116 through 119. 
X6# = Level value; pre-mixer gain and output volume	 See table 6 on page 120 through 123. 
X6$ = Mute status				    0 = unmute	

								        1 = mute
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Command and Response Table for DSP SIS Commands (continued)

Command ASCII command
(host to device)

Response
(device to host)

Additional description

Audio group master commands

NOTE:	 •	See Group Masters on page 69, for more information about audio group masters.

•	A group must have assigned members for these commands to have an effect.

•	For X6^, a positive (+) value is assumed unless a negative (–) value is specified.

•	 If entering a X6^ value outside the valid range for the group or outside the soft limits, the DMP 64 
responds with an “invalid parameter” (E13) error.

•	X6^, X6&, and X6* values can be sent without leading zeroes; responses are always 5 digits.

Set a group fader control EDX6%*X6^GRPM} GrpmX6%*X6^] Set the group fader to a value 
of X6^.

Example: Ed2*-293*GRPM} GrpmD02*-00293] Set the group 2 fader control 
to -29.3 dB.

Raise a group fader control EDX6%*X6&+GRPM} GrpmX6%*X6^] Increase the level of the X6% 
group fader by X6& dB.

Example Ed2*30+GRPM} GrpmD02*-00263] Raise the group 2 fader 3 dB 
(from -29.3 dB to -26.3 dB, 
starting from the level set 
in the “Set a group fader 
control” example, above.

Lower a group fader control EDX6%*X6&-GRPM} GrpmX6%*X6^] Decrease the level of the X6% 
group fader by X6& dB.

View the group fader control 
level

EDX6%GRPM} GrpmX6%*X6^] In verbose modes 1 and 2, the 
response is simplified to 
X6^].

Mute a group mute control EDX6%*1GRPM} GrpmDX6%*+00001] Mute all blocks in group X6%.
Clear (unmute) a group 
mute control

EDX6%*0GRPM} GrpmDX6%*+00000] Umute all blocks in group 
X6%.

View a group mute control EDX6%GRPM} GrpmDX6%*X6$] For group masters, X6$ 
is always expressed as a 
positive or negative 5-digit 
value.

Set soft limits ELX6%*X6*upper*X6*lowerGRPM} Set the groups soft limits to 
X6* and X6*.GrpmLX6%*X6**X6*]

Example: EL2*+60*-60GRPM} GrpmL02*+00060*-00060] Set the upper soft limit for the 
group 2 fader to +6.0 dB and 
the lower limit to -6.0 dB.

View soft limits ELX6%GRPM} GrpmLX6%*X6**X6*] In verbose modes 0 and 1, 
the response is simplified to 
X6**X6*].

View group type EPX6%GRPM} GrpmPX6%*X6(] Show the group type (X6() 
for group X6%. In verbose 
modes 0 and 1, the response 
is simplified to X6(].

View group members EOX6%GRPM} GrpmOX6%*X6)1*X6)2* 
...*X6)16]

X6) is the control or mix point. 
In verbose modes 0 and 1, 
the response is simplified to 
X6)1*X6)2*...*X6)16].

NOTES: X6) = Audio level control, or mix-point 
select

See Table 1 on page 111 and 112.

X6% = Group master group number 01 - 32
X6^ = Group fader level dB value, in 0.1 dB increments, using negative numbers but not decimal 

places. –100.0 dB to +80.0 dB is represented by –1000 to 800. The valid 
range depends on the type of gain or trim block assigned to the group number 
(X6%).

X6& = Group fader increase/decrease dB value, in 0.1 dB increments, to raise or lower a group fader.
X6* = Group fader soft limit dB value, in 0.1 dB increments. The valid range must be within the range for 

the gain block grouped in X6%.
X6( = Group type   6 = gain 

12 = mute
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Command ASCII command
(host to device)

Response
(device to host)

Additional description

Protected configuration

NOTE:	 The DMP 64 can save and recall a Personal Identification Number (PIN)-protected configuration, including 
mic mixes, parameters, variables, and values (with the exception of the device’s IP address). The protected 
configuration is useful to establish the DMP 64 in a known state, either as a troubleshooting tool or as a 
baseline configuration.

Save the configuration E S X7) PCFG} PcfgS] Save the configuration to the 
protected memory location.

Recall the configuration E RPCFG} PcfgR] Recall the protected 
configuration

Change the PIN E P X7)old*X7)
newPCFG}

PcfgP X7)new] Overwrite the old PIN  
(X7)old) with the new one (X7)
new).

Query configuration saved 
status

E QPCFG} X7!]

NOTES:	 X7) = Personal Identification Number (PIN)	 Four numeric digits, default = 0000 
X7! = Protected configuration status		  0 = no protected configuration saved 
						      1 = protected configuration saved 

Command and Response Table for DSP SIS Commands (continued)

Table 1. X6) — Level Control and Mix-point Selection

NOTE:	 Circled numbers refer to DSP Processors Addressable by 
SIS Commands on page 103.

a Input Gain Control X6) b Pre-mixer Gain X6)

Mic/Line Input 1 40000 Mic/Line Input 1 40100

Mic/Line Input 2 40001 Mic/Line Input 2 40101

Mic/Line Input 3 40002 Mic/Line Input 3 40102

Mic/Line Input 4 40003 Mic/Line Input 4 40103

Mic/Line Input 5 40004 Mic/Line Input 5 40104

Mic/Line Input 6 40005 Mic/Line Input 6 40105

e Volume Out Control X6)

Output 1 60000

Output 2 60001

Output 3 60002

Output 4 60003
  

f Virtual Return Gain X6)

Output A 50000

Output B 50001

Output C 50002

Output D 50003
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Command and Response table for DSP SIS commands (continued)

c Main Mix-Point X6) c Main Mix-Point X6)

Input 1 to Output 1 20000 Input 2 to Output 1 20100

Input 1 to Output 2 20001 Input 2 to Output 2 20101

Input 1 to Output 3 20002 Input 2 to Output 3 20102

Input 1 to Output 4 20003 Input 2 to Output 4 20103

Input 1 to VR A 20004 Input 2 to VR A 20104

Input 1 to VR B 20005 Input 2 to VR B 20105

Input 1 to VR C 20006 Input 2 to VR C 20106

Input 1 to VR D 20007 Input 2 to VR D 20107

Input 3 to Output 1 20200 Input 4 to Output 1 20300

Input 3 to Output 2 20201 Input 4 to Output 2 20301

Input 3 to Output 3 20202 Input 4 to Output 3 20302

Input 3 to Output 4 20203 Input 4 to Output 4 20303

Input 3 to VR A 20204 Input 4 to VR A 20304

Input 3 to VR B 20205 Input 4 to VR B 20305

Input 3 to VR C 20206 Input 4 to VR C 20306

Input 3 to VR D 20207 Input 4 to VR D 20307

Input 5 to Output 1 20400 Input 6 to Output 1 20500

Input 5 to Output 2 20401 Input 6 to Output 2 20501

Input 5 to Output 3 20402 Input 6 to Output 3 20502

Input 5 to Output 4 20403 Input 6 to Output 4 20503

Input 5 to VR A 20404 Input 6 to VR A 20504

Input 5 to VR B 20405 Input 6 to VR B 20505

Input 5 to VR C 20406 Input 6 to VR C 20506

Input 5 to VR D 20407 Input 6 to VR D 20507

Ñ Virtual Return Mix-Point X6) Ñ Virtual Return Mix-Point X6)

VR A to Output 1 20600 VR B to Output 1 20700

VR A to Output 2 20601 VR B to Output 2 20701

VR A to Output 3 20602 VR B to Output 3 20702

VR A to Output 4 20603 VR B to Output 4 20703

VR A to VR A NA VR B to VR A 20704

VR A to VR B 20605 VR B to VR B NA

VR A to VR C 20606 VR B to VR C 20706

VR A to VR D 20607 VR B to VR D 20707

VR C to Output 1 20800 VR D to Output 1 20900

VR C to Output 2 20801 VR D to Output 2 20901

VR C to Output 3 20802 VR D to Output 3 20902

VR C to Output 4 20803 VR D to Output 4 20903

VR C to VR A 20804 VR D to VR A 20904

VR C to VR B 20805 VR D to VR B 20905

VR C to VR C NA VR D to VR C 20906

VR C to VR D 20807 VR D to VR D NA
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Table 2.  Mix-point Gain Only
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Table 3.  Post-mixer Trim and Mix-point Gain
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Table 4.  Mix-point Gain Only
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Table 5.  X6@ — Level Control and Mix-point Selection
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Table 6.  X6# — Pre-mixer, Virtual Return, and Output Level Control
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HTML Operation

This section describes HTML operation and control of the DMP 64, including:

•	 Download the Startup Page

•	 Status Tab

•	 Configuration Tab

•	 File Management Tab

•	 Control Tab

•	 Special Characters

The DMP 64 can be controlled and operated through its Ethernet port, connected by 
LAN or WAN, using a web browser such as the Microsoft® Internet Explorer. The browser 
display of device status or operation has the appearance of web pages. This chapter 
describes the factory-installed HTML pages, which are always available and cannot be 
erased or overwritten.

NOTE:	 If the Ethernet connection to the device is unstable, try turning off the proxy 
server in the Web browser. In Microsoft Internet Explorer, click  
Tools > Internet Options > Connections > LAN Settings, uncheck the 
"Use a proxy server..." box, and then click OK.

Download the Startup Page
Access the device using HTML pages as follows:

1.	 Start the Web browser program.

2.	 Click in the browser Address field.

3.	 Enter the device IP address directly into the Address field.

NOTE:	 If the local system administrators have not changed the value, the 
factory‑specified default IP address is 192.168.254.254.

4.	 If a custom display page is available, enter a slash (/) and the file name to open.

NOTE:	 The browser Address field should display the address in the following 
format: xxx.xxx.xxx.xxx/{optional_file_name.HTML}. The following 
characters are invalid in file names: 
{space} + ~ , @ = ‘ [ ] { } < > ’ " ; : > \ ?
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5.	 Press the keyboard <Enter> key. The device checks to see if it is password-
protected.

a.	 If the device is not password-protected, it checks and downloads the HTML 
pages (proceed to step 7).

b.	 If the device is password-protected, the device downloads the Connect to page 
(see figure 62).

Connect to 192.168.254.254

DMP 64

User Name:

Password:

Remember my password

OK Cancel

Figure 62.	 Connect To Page

6.	 Click in the Password field and type in the appropriate administrator or user 
password. Click the OK button.

NOTE:	 A User Name entry is not required.

7.	 The device checks several possibilities, in the following order, and then responds 
accordingly:

a.	 Does the address include a specific file name, such as 10.13.156.10/file_
name.HTML?  If true, the device downloads that HTML page.

b.	 Is there a file in the device memory named "index.HTML"? 
If true, the device downloads "index.HTML" as the default startup page.

c.	 If neither of the conditions are true, the device downloads the factory‑installed 
default startup page, "nortxe_index.HTML" (see figure 63 on the next page), 
also known as the System Status page.
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Status Tab

System Status Page
The System Status page (see figure 63) provides an overall view of the status of the 
device, including system information, power supply status, and serial port settings. The 
System Status page is the default page when establishing a connection to the device. 
Access the System Status page from other pages by clicking the Status tab.

Figure 63.	 System Status Page
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Configuration Tab

System Settings Page
Click the Configuration tab to download the System Settings page (see figure 64). 
The screen consists of fields to view and edit IP administration and system settings. 
Passwords and Firmware Upgrade pages are accessed by clicking the appropriate 
link on the left. For basic information about IP addresses and subnetting, see 
Ethernet (LAN) Port on page 93.

Figure 64.	 System Settings Page

On password-protected connections, there are two levels of protection: administrator and 
user. Administrators have full access to the Passwords and Firmware Upgrade pages. 
Users have view only access.

•	 Ethernet connection to the device, either entering SIS commands (see SIS 
Programming and Control on page 92), or using the Extron DSP Configurator 
Program (see DMP Software on page 14), is password-protected.

•	 Connection via any RS-232 port is not password-protected.

IP Settings Fields

The IP settings fields provide a location for viewing and editing settings unique to the 
Ethernet interface. After editing any of the settings on this page, click the Submit button 
at the bottom of the section to make the changes.

Unit Name Field

The Unit Name field contains the name of the device. This name field can be changed to 
any valid name, up to 24 alphanumeric characters.

NOTE:	 The following characters are invalid in the matrix name: 
+  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  "  ;  :  >  \  and ?.
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DHCP Selection

The DHCP On selection directs the device to ignore any entered IP addresses and obtain 
its IP address from a Dynamic Host Configuration Protocol (DHCP) server (if the network 
is DHCP capable). The DHCP Off selection turns DHCP off. Contact the local system 
administrator for additional information on your network.

IP Address Field

The IP Address field contains the IP address encoded in the flash memory of the 
connected device. 

Valid IP addresses consist of four 1-, 2-, or 3-digit numeric subfields separated by dots 
(periods). Each field can be numbered from 000 through 255. Leading zeroes, up to three 
digits total per field, are optional. Values of 256 and above are invalid.

The factory-installed default address is 192.168.254.254, but if this conflicts with other 
equipment at the installation site, change the IP address to any valid value.

NOTE:	 IP address changes can cause conflicts with other equipment. Only local 
system administrators should change IP addresses.

Gateway IP Address Field

The Gateway IP Address field identifies the address of the gateway to the mail server to 
be used if the device and the mail server are not on the same subnet.

The gateway IP address has the same validity rules as the system IP address.

Subnet Mask Field

The Subnet Mask field is used to determine whether the device is on the same subnet as 
the mail server when you are subnetting. 

MAC Address Field

The Media Access Control (MAC) address is hardcoded in the device and cannot be 
changed.

Firmware Field

The Firmware field displays the current firmware version being used by the device.

Model Field

The Model field displays the Extron model number of the device.

Part Number Field

The Part Number field displays the Extron Electronics part number of the device.
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Date/Time Settings Fields

The Date/Time settings fields (see figure 65) provide a location for viewing and setting 
the time functions.

Figure 65.	 Date/Time Settings Fields

Change the date and time settings as follows:

1.	 Click the desired variable box. Adjustable settings include month, day, year, hours, 
minutes, AM/PM, and (time) zone. A drop-down box appears (the year drop-down 
box is selected in figure 65).

2.	 If all variable selections are not visible, click and drag the slider or click the up 
 button or down  button until the desired variable is visible.

3.	 Click the desired variable.

NOTE:	 If setting the time, set the local time. The Zone variable allows you to 
then select the offset from Greenwich Mean Time (GMT). 

	 The Zone field identifies the standard time zone selected and displays 
the amount of time, in hours and minutes, the local time varies from GMT 
international time reference.

4.	 Repeat steps 1 through 3 for other variables that need to be changed.

5.	 If appropriate, click the Daylight Savings selection to turn on the daylight savings 
time feature.

NOTE:	 When Daylight Saving Time is on, the device automatically updates its 
internal clock between Standard Time and Daylight Saving Time in the spring 
and fall on the date the time change occurs in the country or region selected. 
When Daylight Saving Time is turned off, the device does not adjust its time 
reference.

6.	 Click Submit to enter the changes.
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Passwords Page
Access the Passwords page (see figure 66), by clicking the Passwords link on the system 
settings page.

Figure 66.	 Passwords Page

The fields on the passwords page are for entering and verifying administrator and user 
passwords. Passwords are case sensitive and limited to 12 uppercase and lowercase 
alphanumeric characters. Each password must be entered twice: once in the User 
Password field and then again in the Re-enter User Password field. Characters in these 
fields are masked by asterisks (*****). If password protection is not desired, leave the User 
Password field and the Re-enter User Password field blank. After entering the desired 
password in both fields, click Submit.

NOTE:	 An administrator password must be created before a user password can be 
created.

Change a Password

To change a password, type the new password in the User Password and Re‑enter 
User Password fields and click Submit.

Clear a Password

To clear an existing password so that no password is required, enter a single space in the 
User Password and Re-enter User Password fields and click Submit.
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Firmware Upgrade Page
The Firmware Upgrade page provides a way to verify the current firmware version and 
to replace the firmware without taking the device out of service. Click the Firmware 
Upgrade link on the System Configuration page to access the Firmware Upgrade page 
(see figure 67).

The current firmware version is displayed above the upload box for reference.

Figure 67.	 Firmware Upgrade Page

To update the device firmware:

NOTE:	 The Firmware Upgrade page is only for replacing the firmware that controls 
device operation. 

1.	 Visit the Extron Web site, www.extron.com, and click the Download Center tab.

2.	 Click the Firmware link (see figure 68 on the next page).

3.	 Select the appropriate firmware file and click Download.

4.	 Enter the requested information.
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5.	 Click Download to copy the firmware to your computer.

2

1

5

4

3

NOTE: The version, release date,
 and size shown are example
 values only.

Download DMP64_FW1x01.exe

DMP 64 Digital Matrix Processor
Firmware for DMP 64

19-2247-50       V1.01 January 17, 2011 2.2 MB  

DMP 64 FW1x01.exe

Download

Firmware

Figure 68.	 Location of Firmware Upgrade Files on the Website
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6.	 Click Run twice (see figure 69, f). The PC downloads the firmware update from the 
Extron Web site and starts the installation program to extract the firmware file.

	

Folder where
firmware is
installed

NOTE: The version shown is a 
sample value only.

Name:  DMP64_FW1x01.exe

Type:  Application, 2.26 MB

From:  www.extron.com

Name:  FirmwareInstall-DMP64_Upgrade

Publisher:  Extron Electronics

6

6

7

8

Welcome to the Extron Installation Program for
the DMP64 Firmware Upgrade v1.01

The Extron Installation Program will install the updated
�rmware on your computer.  To continue, click Next.

The InstallShield Wizard has successfully installed the

Firmware Update.  The release notes can be found at

C:\Program Files\Extron\Firmware\DMP 64\v1.01

Figure 69.	 Downloading Firmware Upgrade Files
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7.	 Click Next (see figure 69, g on previous page). The program extracts and places the 
firmware files in a folder identified in the InstallShield Wizard window.

NOTE:	 Write down the folder where the firmware file is saved.

8.	 Click Finish (see figure 69, h) to exit the program.

9.	 Connect the PC to the device via the Ethernet port.

10.	Access the device using the HTML pages (see Download the Startup Page on 
page 120 .)

11.	Click the Configuration tab.

12.	Click the Firmware Upgrade link.

13.	Click the Browse button. An open file window appears.

14.	Navigate to the folder where the firmware upgrade file was saved. Select the file.

NOTE:	 Valid firmware files must have the file extension ‘.S19’. Any other file 
extension is not a firmware upgrade. The original factory-installed firmware is 
permanently available on the device. If the attempted firmware upload fails for 
any reason, the device automatically reverts to the factory-installed firmware.

15.	Click Open.

16.	Click Upload. The firmware upload to the device can take a few minutes.
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File Management Tab

File Management Page
To delete files such as HTML pages from the connected device or to upload custom 
files to the device, click the File Management tab. The device downloads the file 
management HTML page (see figure 70).

Figure 70.	 File Management Page

NOTE:	 The files listed in figure 70 are shown for example only.

To delete a file, click the Delete button at the right of that file.

Upload your own file as follows:

NOTE:	 The following characters are invalid in file names: 
{space} + ~ , @ = ‘ [ ] { } < > ’ " ; : > \ and ?.

1.	 Click the Browse button.

2.	 Browse through the system and select the desired files.

NOTE:	 If you want one of the pages that you create and upload to be the 
default startup page, name that file "index.HTML."

3.	 Click the Upload File button. The selected files appear in the list.
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Control Tab

Audio Settings Page
The Audio Settings page provides a way to set the input audio gain and attenuation, 
output volume, and mix-point adjustments including level control, and mute or unmute. 
Access the Audio Settings page by clicking the Audio Settings link on the control page 
(see figure 71).

Figure 71.	 Video and Audio Settings Page

Change the Input Gain and Attenuation

Users can set the level of audio gain or attenuation (–18 dB to +80 dB) for each input from 
the audio settings page. Audio levels can be adjusted so there are no noticeable volume 
differences between sources.

Change an input audio level setting as follows:

1.	 Next to the desired input number, click the input level drop-down box. A drop-down 
scroll box appears (right).

2.	 Click and drag the slider or click the scroll up  button or scroll down  
button until the desired audio level is visible. 
Alternately the + and - boxes increment the level up or down one step.

3.	 Click the desired gain or attenuation value. The range is –18 to +80 dBu.

4.	 Repeat steps 1 through 3 for each input.
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Mute and Unmute Inputs and Outputs

Pressing the Mute button toggles mute on or off. When muted, the Mute button is red and 
displays Muted. When unmuted it returns to gray and displays Mute.  

Mute and umute as follows:

1.	 Next to the desired input or output press the Mute button to toggle mute on (button 
turns red) or off (button is gray ).

2.	 Repeat for each input and output.

Mute and Unmute the Mixer-points

The HTML mixer does not include control for the virtual bus send and receive mixer. When 
a mixer-point is muted (default) no signal passes. When unmuted, the signal passes from 
selected input to the selected output. 

Mute and unmute the mixer-points as follows:

1.	 Click the desired input and output combination. The selected mix-point turns green. 
Mic 1 to Output 4 is shown selected (see figure 72).

Figure 72. Output Selection Drop Box

2.	 Click the Mute button to either toggle mute on or off.

3.	 Repeat steps 1 and 2 for each I/O combination.

Change the Mic Mix Audio Level

To change the mix-point audio input level:

1.	 Click the desired input and output combination. The selected mix-point turns green. 
Mic 1 to Output 4 is shown selected (see figure 72).

2.	 Click the Mic Mix Audio Level drop-down box. A list box appears. Alternately the 
+ and - boxes increment the level up or down one step.

3.	 Click and drag the slider or click the scroll up  button or scroll down  button until 
the desired audio level is visible.

4.	 Click the desired gain or attenuation value. The range is -35 to +25 dB.

5.	 Repeat steps 1 through 3 for each mix-point.
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Change the Output Volume Level

The output volume attenuates the signal from full volume down to 0 volume in 100 steps. 
Users can set individual output volume levels from a range of –100 dB (full attenuation, 
minimum volume) to 0 dB (no attenuation, full volume).

Change an output audio level setting as follows:

1.	 Next to the desired output number, click the output level drop-down box. A 
drop‑down list box appears.

2.	 Click and drag the slider or click the scroll up  button or scroll down  button until 
the desired audio level is visible. 
Alternately the + and - boxes increment the level up or down one step.

3.	 Click the desired attenuation value. The range is –100 to 0 dB.

4.	 Repeat steps 1 through 3 for each output.

Group Controls Page
If group controls have been set using SIS commands or DSP Configurator, the group 
controls page provides access to those controls (see figure 73). Group controls cannot 
be set using the HTML pages. Access the group controls page by clicking the Group 
Controls link on the left of the control page.

Figure 73.	 Group Controls Page

To adjust a group control:

•	 Next to the desired group control, directly input a value by clicking in the box and 
typing a value, or use the + and – box to increment or decrement the value by one.

•	 Repeat for each group.

NOTE:	 The range of each group control is displayed under the value box.
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Presets Page
The Presets page is used to save new presets created on the Audio Settings page (see 
figure 74). Presets saved using this HTML page only include the gain controls on that 
page. However, presets created using DSP Configurator include all signal processing 
blocks. When saving a preset from the HTML page, be certain not to overwrite those 
presets created by DSP Configurator.

Figure 74.	 Presets

To recall a preset to be the current configuration, click the button associated with the 
desired preset.

NOTE:	 When presets are recalled using the HTML page, signal processing 
adjustments saved as part of the preset (under DSP Configurator control only) are 
recalled and overwrite the current audio settings.  
When a partial preset is recalled, it overwrites that portion of the current 
configuration addressed by the preset, leaving the remainder unchanged.

Special Characters
The HTML language reserves certain characters for specific functions. The device will not 
accept these characters as part of preset names, the device name, passwords, or locally 
created file names.

The device rejects the following characters: 
{space} + ~ , @ = ‘ [ ]  { } < > ’ " ; : > \ ?
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Reference Information

This section contains reference information for the DMP 64, including:

•	 Firmware Loader

•	 DMP 64 Hardware Reset Modes

•	 Mounting the DMP 64

Firmware Loader
The DSP Configurator program includes a firmware loader 
program which allows replacing the firmware without taking 
the DMP 64 out of service. Download the desired firmware file 
from the Extron website, (see Firmware Upgrade Page on 
page 127 for instructions.) 

To access the firmware uploader:

1.	 Select Tools>Firmware Loader.

2.	 The Add Device dialog box appears. Type the IP 
address of the DMP 64, then press OK.

NOTE:	 If the IP has not been changed, the 
default IP address is: 192.168.255.255
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The Firmware Loader screen appears. 

4

5

3.	 From the toolbar, select File>Open.

4.	 Locate the downloaded firmware file and click on it.

5.	 Click Begin on the main screen. The total progress bar tracks 
the loading progress.

6.	 When the upload is finished, select File>Exit to exit the 
program.

The firmware upload is complete.
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DMP 64 Hardware Reset Modes
DMP 64 Reset Mode Summary

Mode Mode Activation Result Purpose/Notes
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1 Press and hold the reset button, then 
apply power.

NOTE:	 After a mode 1 reset, update the 
DMP 64 firmware to the latest version. 
DO NOT operate the firmware version 
that results from this mode reset.

The DMP 64 reverts to the factory 
default firmware.
Event scripting does not start if 
the DMP 64 is powered on in this 
mode. All user files and settings 
(drivers, adjustments, IP settings) are 
maintained.

NOTE:	 If you do not want to update the 
firmware, or perform a mode 1 reset by 
mistake, cycle power to the DMP 64 to 
return to the firmware version running 
prior to the reset.

This mode reverts to the 
factory default firmware 
version if incompatibilty 
issus arise with user-loaded 
firmware.

NOTE:	 User-defined web 
pages may not work 
correctly if using an earlier 
firmware version.

R
un
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to

p
 

E
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s

3 With the power on, press and hold the 
reset button until the Power LED blinks 
once (3 sec.), then release and within 
1 second press reset momentarily 
(<1 sec).

Mode 3 toggles events on or off. Front 
panel level indicators blink twice to 
indicate events has toggled on, or three 
times to indicate event logging has 
toggled off.

Useful for troubleshooting

NOTE:	 Nothings happens if the 
momentary press does not occur within 
1 second.
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4 With power on, press and hold the 
reset button for about 6 sec. until the 
Power LED blinks twice (once at 3 sec., 
again at 6 sec.), then release and within 
1 second press reset momentarily 
(< 1 sec.).

NOTE:	 Nothings happens if the 
momentary press does not occur within 
1 second.

Mode 4:
•	 Enables ARP capability.

•	 Set the IP address to default.

•	 Sets the subnet to default.

•	 Sets the gateway address to 
default.

•	 Sets port mapping back to default.

•	 Turns DHCP off.

•	 Turns events off.

Enables resetting IP address 
information using ARP and 
MAC address.
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5 With power on, press and hold the 
reset button for about 9 sec. until the 
Power LED blinks three times (once at 
3 sec., again at 6 sec., again at 9 sec.), 
then release and within 1 second press 
Reset momentarily (< 1 sec.). 

NOTE:	 Nothing happens if the 
momentary press does not occur within 
1 second.

Mode 5 performs a complete reset 
to factory defaults, except for 
firmware:
•	 Does everything mode 4 reset does.

•	 All mix-points mutee and set to 
0 dB.

•	 All outputs unmuted and set to 
0 dB.

•	 DSP Processing returned to 
defaults and bypassed.

•	 All inputs muted and set to 0 dB.

•	 All presets and group master 
memory cleared.

Useful to start over with 
configuration or uploading, or 
to restart events.
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Mounting the DMP 64
The 1U high, half rack width, 9.5 inch deep DMP 64 Digital Matrix Processor can be:

•	 Set on a table, 

•	 Mounted on a rack shelf, 

•	 Mounted under a desk or tabletop, or 

•	 Mounted on a projector bracket.

Tabletop Use
The DMP 64 includes rubber feet (not installed). For tabletop use, attach a self‑adhesive 
rubber foot to each corner of the bottom of the unit.

UL Rack Mounting Guidelines
The following Underwriters Laboratories (UL) guidelines pertain to the safe installation of 
the DMP 64 in a rack.

1.	 Elevated operating ambient temperature — If installed in a closed or multi-unit 
rack assembly, the operating ambient temperature of the rack environment can be 
greater than room ambient temperature. Therefore, install the unit in an environment 
compatible with the maximum ambient temperature (Tma = +122 °F, +50 °C) 
specified by Extron. 

2.	 Reduced air flow — Install the equipment in a rack so that the amount of air flow 
required for safe operation of the equipment is not compromised. 

3.	 Mechanical loading — Mount the equipment in the rack so that a hazardous 
condition is not achieved due to uneven mechanical loading.

4.	 Circuit overloading — Connect the equipment to the supply circuit and consider the 
effect that circuit overloading might have on overcurrent protection and supply wiring. 
Appropriate consideration of equipment nameplate ratings should be used when 
addressing this concern.

5.	 Reliable earthing (grounding) — Maintain reliable grounding of rack-mounted 
equipment. Pay particular attention to supply connections other than direct 
connections to the branch circuit (e.g. use of power strips). 

Rack Mounting
For optional rack mounting, do not install the rubber feet. Mount the DMP 64 on a 19 inch 
Universal 1U or Basic rack shelf. Follow the instructions included with the rack mount kit 
to install the DMP 64.

Furniture Mounting
Furniture mount the DMP 64 using the optional mounting kit (Extron MBU 125, part 
number 70-077-01, under-desk, or Extron MBD 129, part number 70-077-02, 
through‑desk). Follow the instructions included with the mounting kit to install the 
DMP 64.

Table or Wall Mounting
The MBU 125 table or wall mounting brackets extend approximately 1/4 inch (6.4 mm) 
above the top surface of the enclosure. This design allows for an air space between the 
enclosure and the surface to which it is mounted. Follow the instructions included with the 
mounting kit to install the DMP 64.
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Extron Headquarters
+1.800.633.9876 (Inside USA/Canada Only)

Extron USA - West	 Extron USA - East 
+1.714.491.1500	 +1.919.850.1000 
+1.714.491.1517 FAX	 +1.919.850.1001 FAX

Extron Europe
+800.3987.6673 
(Inside Europe Only)

+31.33.453.4040 
+31.33.453.4050 FAX

Extron Asia
800.3987.6673 
(Inside Asia Only)
+65.6383.4400
+65.6383.4664 FAX

Extron Japan
+81.3.3511.7655
+81.3.3511.7656 FAX

Extron China
+4000. 398766 
(Inside China Only)

+86.21.3760.1568 
+86.21.3760.1566 FAX

Extron Middle East
+971.4.299.1800
+971.4.299.1880 FAX

Extron Korea
+82.2.3444.1571
+82.2.3444.1575 FAX

Extron India
1800.3070.3777 
(Inside India Only)

+91.80.3055.3777 
+91.80.3055.3737 FAX

© 2013 Extron Electronics   All rights reserved.   www.extron.com

Contact Information

Extron Warranty

Extron Electronics warrants this product against defects in materials and workmanship for a period of three years 
from the date of purchase. In the event of malfunction during the warranty period attributable directly to faulty 
workmanship and/or materials, Extron Electronics will, at its option, repair or replace said products or components, 
to whatever extent it shall deem necessary to restore said product to proper operating condition, provided that it is 
returned within the warranty period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America: 
Extron Electronics 
1230 South Lewis Street 
Anaheim, CA 92805 
U.S.A.

 
Japan: 
Extron Electronics, Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe and Africa: 
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China: 
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Asia: 
Extron Asia Pte Ltd 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Middle East: 
Extron Middle East 
Dubai Airport Free Zone 
F12, PO Box 293666 
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE:	 If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process. 
 
USA:	 714.491.1500 or 800.633.9876	 Europe:	 31.33.453.4040  
Asia:	 65.6383.4400	 Japan:	 81.3.3511.7655 

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron Electronics be liable for direct, 
indirect, or consequential damages resulting from any defect in this product even if Extron Electronics has been 
advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.

www.extron.com
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